- PORTAFOLIO SECCION 2.
DISENO DEL MAPA
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14. CREAR UNA COMPOSICION (VISTA) DE CAPAS.

14.1.- Una capa representa la distribucion espacial de una variable geografica mientras que un mapa es
una composicion de capas. Por lo general una capa representativa de una variable geografica puede ser
acompafada con la capa de hidrografia, vialidad, etc., lo cual complementa y aumenta el detalle de la
informacion espacial. Conjuntamente si a esta capa se le afiade otros elementos cartograficos como
localizacion relativa, sistema de coordenadas, leyenda y escala, estaremos elaborando una version

acabada de un mapa.

El cuadro 3 describe las categorias y productos a presentar en el portafolio municipal de Campo Elias,

y los mapas / capas insumos a utilizar.

| UBICACION RELATIVA DEL MUNICIPIO |

14.2.- Ubicacion relativa del municipio Campo Elias. Despliegue el mapa TRUJILLO MUNICIPIOS,
luego superpongale en este orden: TRUJILIMITE, AGUA, EMBALSE AGUA VIVA,
MUNICIPIO_CAMPO_ELIAS (Poligonos), HIDROGRAFIA TRUJILLO, genere una vista como la

ilustrada en la figura 14.2. Guarde esta vista ( File > Save View As...), como UBICACION 1.

13

Create
Save View
Save View As...
Create Layout

N

Properties 4
Open Pixel Information

Exit

e
Map View Name  [UBICACION_1] |
Title [

—LIMITE
=1 R TRUIDLLO MU

DL ESTABO TRUIRLO

ESCALE 7:288 800
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Cuadro 3. Productos a generar para el portafolio del municipio Campo Elias.

PRINCIPALES CAPAS

CATEGORIAS PRODUCTOS A UTILIZAR FORMATOS
Ubicacion relativa del - TRUJILLO_MUNICIPIOS RASTER
municipio -

Localizacion Limites municipales - TRUJILLO_MUNICIPIOS RASTER
Division Politico - MUNICIPIO_CAMPO_ELIAS VECTORIAL
Administrativa municipal al - PARROQUIA_CAMPO_ELIAS VECTORIAL
2015 - PARROQUIA_ARNOLDO_GABALDON VECTORIAL
El Relieve en el municipio - MED_REGIONAL RASTER
- MED_CAMPO_ELIAS RASTER
Puntos extremos - MED_REGIONAL RASTER
altitudinales - MED_CAMPO_ELIAS VECTORIAL
El Territorio Pisos altitudinales del - PISOS ALTITUDINALES RASTER / VECTORIAL
municipio - MED_CAMPO_ELIAS VECTORIAL
Estructuras y unidades - GEOLOGIA RASTER
litolégicas
Formas del paisaje - GEOMORFOLOGIA RASTER
Distribucion de fa - TEMPERATURA RASTER
temperatura superficial
Distribucién de la precipitacion
. anal 1908 o014 P -PP_1998_2014 RASTER
Clasificacion de pisos - PISOS_TERMICOS RASTER / VECTORIAL
térmicos -
Clasificacion climaticade | _ | a_KoOPPEN VECTORIAL
Kdeppen -
Distribucion de las cuencas - MED_REGIONAL RASTER
La Hidrografia hidrogréficas - HHDROGRAFIA_TRUJILLO VECTORIAL
Principales drenajes - MUNICIPIO_CAMPO_ELIAS VECTORIAL
- HHDROGRAFIA_TRUJILLO VECTORIAL
Distribucion de las
Coberturas coberturas y usos de la - COBERTURAS_1996 RASTER
. tierra
Areas de Parques nacionales y areas
conservacion y d . - ABRAE_TRUJILLO RASTER
L e conservacion
preservacion
- B1_LANDSAT 19960813 RASTER
- B2_LANDSAT 19960813 RASTER
El municipio desde Composiciones a color de - B3_LANDSAT19960813 RASTER
el espacio escenas LANDSAT 1996 - B4 LANDSAT19960813 RASTER
- B5_LANDSAT 19960813 RASTER
- B7_LANDSAT 19960813 RASTER

14.3.- Sin salir de la ventana de la vista
UBICACION 1, proceda a crear una
plantilla (layout) mediante los comandos
File > Create Layout. Note que se

despliega una

ventana de

didlogo

preguntando si mantiene la misma escala
de representacion que tiene en la vista,
click en OK (Figura 14.3)

File Edt Layers Options Help

Create 4 h @ = u
x

Save View
Save View As..,

Create Layout

Properties r

1:775465

Open Pixel Information

Exit Ale+F4

85 - Polyg

[l campo ELias
[ IMunICIPIO CAMPO ELIA
PARROQUIA ARNOLDO ¢
HPARROQUIA CAMPO ELL
—iAED embalse_agua_viva - Polygon
+ Properties
! Legend
lEveaLsE
=i agua - PolygonMapFromSegem

61



Fila B Irest e HED

14.4.- Se despliega luego la plantilla (layout), xed h‘.j' DR 7 %, &, r'"‘!
la cual debemos configurar para obtener un | - o Lo
mapa de salida apaisado y en hoja tamafo _ T A

carta, los margenes deben ser corregidos a
cero, click en Aceptar (Figura 14.4).

Cantpure pigina

14.5.- Una vez en la plantilla, acomodamos el mapa a una posicion centro izquierda que nos deje un
espacio a la derecha para colocar la leyenda del mapa. Procedemos ahora a colocar la rosa de las
direcciones, click en el icono de direccion y escogemos las caracteristicas segin la figura 14.5. y
desplazamos la rosa de las direcciones a la esquina superior derecha del mapa.

ﬂd&;muxnu L=

| m~0m Eq_%mlﬁ- #a
= T Lo Rt Ml Arree
%MM_J IJ S 1844 131.
Ao [ ppr
 Saeh
N =

g

F Corpamy [ 4 =B T 1B

(] ] e ]

Figura 14.5
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14.6.- El siguiente elemento es la escala
gréafica de barras, para poder activar los
iconos es necesario hacer un click sobre

el mapa. Luego click en el icono
respectivo y sefiale las caracteristicas
que se ilustran en la figura 14.6.
Ubique la escala hacia la esquina
inferior derecha de la plantilla.
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14.7.- La leyenda en este caso solo estara dirigida a sefialar el poligono naranja del mapa como el
territorio del municipio Campo Elias. Recuerde que para activar los iconos es necesario hacer un click
sobre el mapa. Luego click en el icono de leyenda y seleccione solo la correspondiente al municipio
Campo Elias.. Ubique esta leyenda en la parte centro derecha de la plantilla (Figura 14.7).
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14.8.- El mapa también requiere un marco graduado en unidades de coordenadas, como la proyeccion
que se utiliza es UTM 19N, Datum WGS84, estableceremos un marco en coordenadas métricas planas
y dado lo escaso del espacio solo colocaremos las coordenadas esquineras. Vaya a los comandos Insert
> MapBorder... y al parecer la ventana de didlogo escoja las pestafias: NeatLine y Corners y siga las
indicaciones ilustradas en la figura 14.8.

Click en aceptar y regrese a la plantilla, posiblemente tenga que mover elementos ya puestos como
leyenda o escala, haciendo un click sobre alguno de estos puede moverlo de sitio, doble click y puede
editar sus propiedades. El mapa ahora tiene las coordenadas UTM correspondientes en las esquinas y
un marco graduado en intervalos de 10000 metros que permite estimar la localizacion geografica de
algin hecho geografico en el mapa.

File Edt | Insert View Help

& B Map View... lD I
= R DT — )
s Legend... : :
b Sl Ha Meat Line [lrid | Graticule | Comers | Outine |
Item P8
3 Map | Scale Text Ll _—_| Heat Line] Grid ] Graticulg
North Arrow,.. ¥ MNeat Line Graduation
€gel & wiates ¥ Comer Conrdinates
nhr Scale ' i [T
o ; Black. | I
1, Nortt Bitmap/Picture. .. ' Degrees - n o ==
Map'  BOX.r Interval(m]  [10000.0 artiiome | T sl -l
i : -
E widh (o) Port sl ==
| — [~ Bold
I ltalic
Aceptar I Cancelar Aaplicea
Aceptar | Cancelar Aplicar Apuda

Figura 14.8

14.9.- La identificacion del mapa se realiza a través de textos los cuales varian en tamafio de letra segiin
la jerarquia de estos. Vaya al icono de texto y escriba los cinco textos que se indican en la figura 14.9,
este es un proceso dindmico donde los textos descritos se deben ajustar al lugar deseado con ayuda del
cursor.
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Figura 14.9

14.10.- Si bien este mapa sirve para ubicar al municipio Campo Elias en el contexto del estado Trujillo,
es buena idea ubicar a este en el contexto nacional. Para esto afiadiremos una imagen BMP que
representa la ubicacion fisica de Trujillo en Venezuela. Haga click en el icono de insertar imagen o

bitmap

tambien parte de la carpeta GUIA_PRACTICA de este ejercicio.
La figura 14.10a ilustra como se inserta la imagen, click OK y luego con la ayuda del cursor ubique la
imagen debajo de la leyenda del poligono del Municipio Campo Elias.

y seleccione la imagen trujillo_ubicacion, la cual se encuentra en la carpeta IMAGENES,
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2 UBICACION_1 - ILWIS.

e = -
@ X DROKKD| =
L e | BB @
i | | Top|  width|  Height | Scale
Abe Fuente: Sistema Hidrulico Trujillan. .. 214.7 168.5 56.5 17.8
Abc PROYECCI N UTM WGESE4 8.6 6.2 47.3

< Ubicaci n Relativa Insert Bitmap or Picture
Abe ESTADO TRUJILLO

Abe MUNICIPIO CAMP
——— Directory ... y teledeteccion’\practicas\poitafolio\guia_practica\imagenes

250834 | ] uillo_ubicacién [ |

1118013 118013
MUNICIPIO
CAMPO ELIAS

ESTADO TRUJILLO
VENEZUELA

Ubicacion Reiativa

PROYECCION UTM
19N WeSa4

h MUNKIPIS CARPS ELLLS

SUCMCACIN T 1 Wi

14.11.- Es necesario
guardar los cambios,
archive esta plantilla
(layout) con el nombre
de UBICACION 1,
segun los pasos
ilustrados en la figura
14.11.

Goymdwan: |5 HUEWD S

Biusmcacion_1

=
R GEy—— |

Mowbss  |UBCADIOW_1 | Tiumdn |

-] Cawey || ELIAS

T [ILA5 Lepons
: e : BLULLO
e :-"-'-:',.'I' L I e Dot = | gy ELA
Lfscacem Reimva
L PROVECCIOM LTI
P ¥, P 160 WGEES

- PAEFC-AR R

-

Figura 14.11

66



14.12.- El ultimo proceso a realizar con cada vista y plantilla a elaborar aqui, es la exportacion de estas
a un formato de imagen. El SIG ILWIS hace la exportacion, de imagenes en Windows bitmap (.BMP)
el cual es un formato de imagen de mapa de bits, propio del sistema operativo Microsoft Windows, que
guarda imagenes de 24 bits (16,7 millones de colores), 8 bits (256 colores) y menos. Una vez
guardados en este formato podemos cambiarlo a conveniencia con el IrfanView. Este formato es solo
de exportacion de imagenes no georreferenciadas

Vaya a los comandos File > Export to Bitmap...en la ventana de didlogo emergente se preguntara por
el nombre de la imagen BMP a crear y resolucion, némbrela UBICACION 1, y acepte por defecto la
resolucion de 150 dpi (puntos por pulgada). El archivo se guardard automaticamente en la carpeta de
trabajo junto a los demas archivos ILWIS, por no ser un formato reconocido por ILWIS, solo podra ser
visualizado en un explorador externo (Figura 14.12). Una vez exportado el mapa, cierre todas las
ventanas desplegadas del ILWIS y regrese a la pantalla maestra.

"B UBICACION_ T - ILWIS
File Edit Insert View Heb
e Fwaa@%%@»u

Open, .,

Save As...

Page Setup
Prink. ., Chrl+F
Export bo Bitmap...

File name
Frezalution [dpi] @E

Size: 1660 % 1275 pisels 02748

File size: 6.0 MEB 1118013

MUNICIPIO
[ OK | Cancel | Hep | . CAMPO ELIAS
ESTADD TRUJILLO
WENEZUELA
Ubicacion Relativa

PROYECCION UTM
19N WESES

- MUNCIRISCARPO ELIZE

Freve:Skhema Hiduioo Troj ks
EHTL
Bl kot | RCE0 1

B e R W ol R R
DEL ESTABE TR L Eyore] = i

T I —= o il 30 km
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14.13. La figura 14.13 muestra el mapa exportado a una imagen BMP, la cual luego podréd ser
incorporado en la maqueta final del portafolio junto con los mapas a elaborar a continuacion.

259834 402742
1118013 1118013
MUNICIPIO
CAMPO ELIAS
ESTADO TRUJILLO
VENEZUELA

Ubicacion Relativa

PROYECCION UTM
19N WGS84

I MURICIMO CAMPD ELIAS

L3HT), TG

I Fuenbe: Sistemp Fidnco Trpiano
Eoecion purin2ii |

e AR BRI PR BRI, .. . 11 e
EL EEFARS TRIALLD S T T [ —
SHEEET 3 U — — — — — — — D013
255824 432742

ABRA ESTA IMAGEN FINAL
CON EL IRFANVIEW,
GUARDELA COMO FORMATO @j
JPEG Y PONGALA EN LA

PLANTILLA DE EVALUACION

15.- Si bien la anterior ubicacion estd referida al contexto politico administrativo, también puede
hacerse otra ubicacion relativa pero en este caso con respecto a la posicion del municipio respecto a la
cordillera de Mérida.

15.1.- Despliegue el mapa MED REGIONAL, pero escoja como representacion la paleta elevacion24 (
Figura 15.1a), luego superpongale en este orden: TRUJILIMITE, AGUA, EMBALSE AGUA VIVA,
MUNICIPIO CAMPO_ELIAS (segmentos), HIDROGRAFIA TRUIJILLO, genere una vista como la
ilustrada en la figura 15.1b. Guarde esta vista ( File > Save View 4s...), como UBICACION 2.
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15.2.- De aqui en adelante puede seguir los pasos detallados en el item 14, y lograr una plantilla y mapa
final de la localizacion del municipio en el contexto de la cordillera andina, sin embargo otra via es
aprovechar la plantilla UBICACION 1. Sin cerrar la vista que acabamos de construir, vuelva a la
pantalla maestra del ILWIS y despliegue la plantilla (layout) UBICACION 1, ubiquemos en la barra
de manejo la vista MapView UBICACION 1 y click botéon derecho para desplegar el men, click en

Replace MapView, y escoja UBICACION 2, click OK (Figura 15.2).

"E'UBICACION. 1 -~ ILWIS
File Edit Insert Wiew Help
| EHE| BB X|Dh
y e OT B |82 @ T v
Item

B Map Border of Map Yiew UBICACL .,

Legend of municipio_campo_glias.... 214.7 89.3 69,0 9.2

Scale Bar of Map Yiew UBICACION_1 222.9 189.2 52.6 10,1 117754685
=HBICACT. .. 164.7 27,9 40,2 40,2

width | Height | Scale
2443 2511

JYE W
Save View As..,

111301239834 — — — — — = Entire Map  Chr4E
i : 2 = i s Set Scale. .
IPIO
N Clear _ LiﬂS

B/

| _EIK I Cancell Help |

[ wunicieio comeo eLiss

15.3.- Dado que el mapa de relieve posee una escala diferente a la escala que presentaba el mapa de
municipios, el sistema debe calcular de nuevo las coordenadas y escala, se recomienda con el cursor
acomodar ligeramente la posicion de la vista y asi mejorar el despliegue de la nueva vista.

Obviamente esta nueva vista contard con diferente titulo y leyenda, en la figura 15.3 se ilustra los
textos que recomendamos para esta plantilla, recuerde que para activar los textos, click sobre ellos y

proceda a editarlos.
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= UBICACION. 1 - ILWIS =
Fle Edt Tnsert View Heip

Ab= Fuente: SATM 2000. 90m

Ak PROYECCE B UTM 15 WaES5E4 4712 16.0
Ab< Locakzact n ded municipio en lacar.., 214.5 47.3 £0.8 17.2
fib< ESTADO TRUJILLD VEMEZUELA 200.1 8.7 86,4 16.8

Fbs MUNICIPIO CAMPO EL AS 205.3 14.5 7.z 15.2

MUNICIPIO
CAMPO ELIAS
ESTADO TRLJILLD
WENEZUELA

|| Localizacion det municipio >
en la cordiliera de Mérida

o 40 km
m——t 077565
403804 Fuente: SRTM 2000 S0m

15.4.- La leyenda la insertamos de una figura elaborada para tal fin, Haga click en el icono de insertar

imagen o bitmap y seleccione la imagen relieve, la cual se encuentra en la carpeta IMAGENES,
tambien parte de la carpeta GUIA PRACTICA de este ejercicio. La figura 15.4 ilustra como se inserta
la imagen, click OK y luego con la ayuda del cursor ubique la imagen debajo de la leyenda del
poligono del Municipio Campo Elias.
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15.5.- Es necesario
guardar los cambios,
archive esta plantilla
(layout) con el nombre
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15.5.
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15.6.- El ultimo proceso a realizar con cada vista y plantilla a elaborar aqui, es la exportacion de estas a
un formato de imagen. Vaya a los comandos File > Export to Bitmap...en la ventana de didlogo
emergente se preguntard por el nombre de la imagen BMP a crear y resolucidon, nombrela
UBICACION 2, y acepte por defecto la resolucion de 150 dpi (puntos por pulgada). El archivo se
guardard automaticamente en la carpeta de trabajo junto a los demas archivos ILWIS, por no ser un
formato reconocido por ILWIS, solo podra ser visualizado en un explorador externo (Figura 15.6). Una
vez exportado el mapa, cierre todas las ventanas desplegadas del ILWIS y regrese a la pantalla maestra.

| BTUBICACIONTZ - TEWIS
File Edit Insert Misw Help

ol Bx DhOaed =

g B e |y = | o & |

SENERS. | Left | Top | width | Height: | Scale

Page Setup 231.3 793 279 103.2
220.1 200.5 S6.4
SSiined. Marer

Alb+F4

File name LEICACION_A
Resolution [dpi] 150 E

Size: 1650 » 1275 piwelz 403604
File size: B.0ME [ = 1123303

262414

MUNICIFIO
0K | Cancel | Hel CAMPO ELIAS
anel ep ESTADO TRUJILLD

; AT ey VENEZUELA

| Localizacian del munic
en la cordiliera de Wér

PROYECCION LITh
19N WIGSES

15.7.- La figura 15.7 muestra el mapa exportado a una imagen BMP, la cual luego podrd ser
incorporado en la maqueta final del portafolio junto con los mapas a elaborar a continuacion.
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262414 403804
L 1123905

MUNICIPIO
CAMPO ELIAS

ESTADO TRUJILLO
VENEZUELA

Localizacién del municipio
en la cordillera de Mérida
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19N WGS84
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e — e S : HaT7565
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ABRA ESTA IMAGEN FINAL CON EL

i
IRFANVIEW, GUARDELA COMO Ejé

FORMATO JPEG Y PONGALA EN LA
PLANTILLA DE EVALUACION

16.- Como el portafolio esta referido a una entidad politico territorial se hace necesario establecer en un
mapa sus limites.

| LIMITES MUNICIPALES |
16.1.- Despliegue el mapa MED CAMPO_ELIAS, pero escoja como
representacion la paleta elevacion24 (Figura 16.1a), luego superpongale en este orden: TRUJILIMITE,
MUNICIPIO_ CAMPO_ELIAS (segmentos), HIDROGRAFIA TRUJILLO, CAMPO_ELIAS y
VIAS CAMPO _ELIAS, genere una vista como la ilustrada en la figura 16.1b. Guarde esta vista ( File
> Save View As...), como LIMITES 1.
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16.2.- Como la imagen elaborada no
especifica las lineas limitrofes del
municipio Campo Elias con los
estados Portuguesa y Lara, asi como
con los municipios trujillanos
Bocono y Carache, procedemos a
crear una capa de segmentos que
discrimine estos limites. AUn sobre la
ventana de la vista LIMITE 1, vaya a
los comandos File > Create >
Segment Map... nombre este mapa
LIMITES EXTREMOS vy escoja el
dominio LIMITE (Figura 16.2).

r

e e

Save View
Save view As...
Create Lavout

Properties
Open Pixel Information

Exit Ale+F4

Properties
Legend

Properties
Legend
LIMITE

_CAMPO
Properties

File Edit Lavers Cptions Help

Paint Map

Rasker Map...
Sample Set...
GeoReference. ..

Coordinate System. ..

Annotation Text.,,

submap...

Create Segment Map

dap Mame

Description:

|LIMITES_E><TEF|NDS

Coordinate System
Min =,
b ><- i

Domain

trujillos

[3m1043.821

| [1032454.325

[388233.821

| [1054334.925

=T

=1

Ok I Cancell Help I

16.3.- Consulte el mapa
TRUJILLO MUNICIPIOS vy a partir
de este trace los limites externos del
municipio Campo Elias. Por ejemplo
los limites entre Campo Elias,
Carache y Bocon¢ vienen dados por
la divisoria de aguas al noroeste del
mapa (Figura 16.3). escoja la
categoria LIMITE MUNICIPAL
como tipo de limite.

Ma value s_pecified vet

Class Name I
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16.4.- En el caso de los limites entre
Portuguesa, Lara y Trujillo, este se
define por el Rio Guaitd hacia el sureste
de la vista (Figura 16.4).

Figura 16.4

16.5.- Dado que estos segmentos no estan conectados para conformar poligonos no es indispensable
verificarlos con el médulo de chequeo, salga del editor y guarde la vista esta vez con este nueva capa
incorporada. Cierre todas las ventanas desplegadas y regrese a la pantalla maestra del ILWIS.

P | tem | Left | Top|  Width|  Height | Scale

Abe MUNICIPIO CAMPO EL AS 211.7 16.1 772 19.2

i3] Map Border of Map View UBICACL... -0.7 -15.9 2444 250.8
1 66- En la pantalla % Scale Bar of Map View UBICACION 2 219.3 188.5 59,2 8.0 1:766883

. 1;\, Morth Arrow of Map View UBICACL. .. 164.7 279 40.2 40,2
maestra despliegue la R : e
: plieg 3.3 E—
plantilla (layout) :
UBICACION 2, save v
. - Save View As...
ubiquemos en la barra :
. . - = Entire Map  Ctrl+E
de manejo la vista | é Set Scale.., WuNICIPIO
Map View | =i _ Cloar \MPO ELIAS
5 . 3 ESTADO TRUJILLO
UBICACION 2 y click .. 5 o s i
boton derecho para . ; ; " Loca:’.fzac.fo'n del municipio
14 : 5 ’ en la cordiliera de Mérda

dqsplegar el mend, 9 - ’ - . - PROYECCION LT
click en Replace : 5 e g 19N WiBSE4

MapView, y escoja
LIMITES _1, click OK

. MapWiew |ELIMITES_1
(Figura 16.6). i ———

& UBICACION_1
B UBICACION_2
23 NUEVD_3
<23 pe -
£ (7] RELLEMO_SANITARIO_GUAK
| (1] SABANETA
#(] VEGETACION_CASTAN
i 3 (] VEGETACION_GUANARE
1 SOFTWARE
hozpital segum
Imagenes

MAGEMES TRUMILLO CLASE

977565 H—4 . I [ i N Fi =)
4073804 Fuerta: SRTh 2000, 90m
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16.7.- Dado que la vista LIMITES_1 posee una escala diferente a la escala que presentaba la vista
UBICACION 2, el sistema debe calcular de nuevo las coordenadas y escala, se recomienda con el

cursor acomodar ligeramente la posicion de la vista y asi mejorar el despliegue.

Obviamente esta nueva vista contard con diferente titulos, leyenda, nuevas imagenes insertadas,
marcos, etc., en la figura 16.7 se ilustra una idea que recomendamos para esta plantilla, recuerde que
para activar los textos, click sobre ellos y proceda a editarlos y las imagenes insertadas proceden de la

carpeta IMAGENES que est4 contenida en la carpeta de la GUIA PRACTICA.

EJ LCIMITES_T - IEWIS
File Edit Insert Yiew Help

FEHES| s B2RX|ID L TRET |

I Ak D m E:E,:j B A | l@l F‘Eh | ﬁ: @

Item | Left |

Top |

idth |

Height | Scale

fbe MUNICIPIO CAMPO EL AS 185.3
B Map Border of Map View LIMITES_1 -4.3
vhr Scale Bar of Map View LIMITES_1 321
Tru Morkh Arrows of Map Wiew LIMITES_L 132.1
A Map Yiew LIMITES_1 5.7

371044

1054335

1032465 Hr

371044

16.5
-16.7
185.9

19.3

13.3

4.0
Z10.4
49.6
40,4
150.4

11.2
251.3

5.0 1114327

40.4

191.3  Li114327

385254

H 10543355

MUNICIPIO CAMPO ELIAS
ESTADO TRUJILLO-VEMNEZUELA

Limites politico administrativos

PROYECCION LITh

o
ST VERIDS ¢

308234

1052465

Fuente: SR 2000. 90m

79



16.8.- Es necesario guardar los cambios, archive esta plantilla (layout) con el nombre de LIMITES 1,

segun los pasos ilustrados en la figura 16.8.

388234

| Guardar como

Guardar er; | = MUEVD_2

x| = ® e E

ratiios

UBICACION_1
UBICACION. 2

N Mombre:  |LIMITES_1]

|ILw1S Layout

£

Guardar I
Cancelar I

16.9.- El ultimo proceso a realizar
con cada vista y plantilla a elaborar

LCIMITES _T"- TEWIS
| File Edit Insert Yiew Help

BxXDk"Head =

@ Tl-‘.' i |:|23|@%|# $|

Left | Top | Width|  Height| Scale |

aqui, es la exportacion de estas a un New
formato de imagen. Vaya a los ORfew

d Fl > E 23AVE S
comandos lle xpozft to Save e,
Bitmap...en la ventana d? didlogo —— e
emergente se preguntara por el Print...  Culep [strativos

nombre de la imagen BMP a crear y
resolucion, némbrela LIMITES 1,
y acepte por defecto la resolucion
de 150 dpi (puntos por pulgada)

t Ea Bitmap...
Alc+Fa

(Figura 16.9). El archivo se
guardard automdticamente en la
carpeta de trabajo junto a los demas
archivos ILWIS, por no ser un
formato reconocido por ILWIS,
solo podrd ser visualizado en un
explorador externo. Una vez
exportado el mapa, cierre todas las
ventanas desplegadas del ILWIS y
regrese a la pantalla maestra.

Z204.1 41.7 472 16.0

181.3 333 92,0 7.6

1337 25.7 d6.4 16.8

1833.3 16.5 4.0 11.2
.4

File name LIMITES_1] Ii.SJNICI
Resalution [dpi] {150 E

ezalution [dpi] A
Size: 1650 = 1275 pirels imitas

File zize: B.0 MEB P

(] I Eancell Help |

16.10.- La figura 16.10 muestra el mapa exportado a una imagen BMP, la cual luego podra ser
incorporado en la maqueta final del portafolio junto con los mapas a elaborar a continuacion.
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AT 388234

1054325
MUNICIPIO CAMPO ELIAS

ESTADD TRUJILLS-VEMEZLELA,
Limmites politico adminstrativas

FROYEGTIIN UTM
16M WESEY

[SHLTE Y |

AT 044 SRR25%4 Fuemic SRETM 2000, Sm

ABRA ESTA IMAGEN FINAL CON EL

Ly
IRFANVIEW, GUARDELA COMO E]é

FORMATO JPEG Y PONGALA EN LA
PLANTILLA DE EVALUACION

| DIVISION POLITICO ADMINISTRATIVA MUNICIPAL AL 2015 ‘

17.- Los municipios en Venezuela estan divididos en parroquias, en este portafolio debemos entonces
mostrar la division politico territorial interna del municipio Campo Elias, para esto como en los casos
anteriores se debe realizar la composicion de capas o vista, luego la plantilla (layout) y finalmente la
exportacion a una imagen raster BMP.
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17.1.- Despliegue la vista LIMITES 1, y superpongale las capas de poligonos
PARROQUIA CAMPO ELIAS y PARROQUIA ARNOLDO GABALDON, luego en la columna de
manejo “arrastre” con el cursor las capas de poligonos correspondientes a las parroquias hasta capa
TRUJILIMITE, de esta manera las capas de HIDROGRAFIA, CAMPO_ELIAS,
VIAS CAMPO ELIAS, LIMITES_EXTERNOS y MUNICIPIO CAMPO_ELIAS serén visibles en la
vista. Guarde esta vista como PARROQUIAS 1 (Figura 17.1). Cierre luego las entanas y regrese a la
pantalla maestra.

[ LIMITES_T ~IEWIS
File Edit Layers Options Help

ECER T |

#ikAED parroguia_arnalda_gabaldon - Palygort
EH-@ parroquia_campo_elias - PolygonMapFrol
campo_ehas - PolygoniMapFromSegmend
LIMITES_EXTERMCS )
wias_campo_elias
hidrografia_truiilla
ruRicipio_campo_elias
jilirnite:
D_CAMPO_ELIAS - MapSubMapCoord:

Figura 17.1

17.2.- En la pantalla maestra despliegue la plantilla (layout) LIMITES 1, ubiquemos en la barra de
manejo la vista MapView LIMITES ly click botoén derecho para desplegar el ment, click en Replace
MapView, y escoja PARROQUIAS 1, click OK . La vista que se despliega no cubre la mitad de la
plantilla destinada para tal fin, debemos entonces ampliar la vista, para ello click en el icono liberador

de escala | “ 1, y de esta manera podra ampliar o reducir el tamano de la vista. Acomode la vista a su
conveniencia y proceda a reescribir los textos (Figura 17.2).
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o
ol

’“..4 LTMITES _1 - IEWIS

_F'ﬁs Edit  Insert Wiew Help -
BLUE tBRX Dy e
J_."“ OB [ & 8| 6w es| ByL

i

£l

Ttem i
R MUNICIPIO CAMPO EL A5 185.3 165 84.0 11,2
B Map Barder of Map Yiew PARROQ... 27 11,1 167.7 197.1
137 Seale Bar of Map Yiew PARROQU... 321 188.9 49.6 8.0 1:159572
£ Morth Arrow of Map Wiew PARROQ... 132.1 19.3 40.4 40,4

|| | EEMap view PARROQUIAS 1 273 18.9 107.7 137,01 1:159572

MUNICIPIO CAMPO ELIAS
ESTADO TRUILLO-VENEZUELA
Limites politico administrativos
PROYECCION LITM

ESTADD
PORTUGUESA

17.3.- Obviamente esta nueva vista contara con diferente titulos, leyenda, nuevas imagenes insertadas,
marcos, etc., esta vista ofrece a la plantilla varias opciones de leyenda, las cuales deben ser escogidas a
conveniencia, por ejemplo en este ejercicio se escogera la leyenda que represente los colores de las
parroquias y la via principal, descartando las deméas para no saturar el nuevo mapa.

Recuerde que para activar los textos, click sobre ellos y proceda a editarlos y las imégenes insertadas
proceden de la carpeta IMAGENES que est4 contenida en la carpeta de la GUIA PRACTICA (Figura
17.3).
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[ZHS s R@X DRNKED| |
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5 253

Mumber of Columns &1 (02 73 4
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¥ Name

CAMPDELIAS SN
MUNICIFID CAMPO'

PARROGUIA ARNC
PARROGUIA CAMF
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PARROGUIA ARNC.
PARROOUIA CAMF

Font Mame I ”F]- ,..':._[ia|. j E
Font Size E

-

I talic

W BoxHeight 0 —]
BaﬂWidth;"HeightHaHo
Etra Height 20 =

i Tranzparent

oK | Cancel | Help |

..... jerte F T 2000 00m

17.4.- Guarde la plantilla como PARROQUIAS 1 (Figura 17.4) y haga la exportacion a imagen BMP
con el mismo nombre. Luego cierre todas las ventanas y regrese a la pantalla maestra.

84
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‘ EL RELIEVE EN EL MUNICIPIO ‘

18.- Dado que el territorio del municipio Campo Elias es montafioso la representacion de su relieve es
un aporte importante para este portafolio. En esta seccion se utilizardn comandos del SIG que permiten
un despliegue 3D de los MED aportados. Para la generacion de una vista 3D del MED REGIONAL
necesitamos crear una georreferencia 3D sobre la cual luego se puede proyectar no solo los MED
aportados en este ejercicio sino también cualquier otra capa de segmentos, poligonal o raster relativa al
espacio aqui representado.

18.1.- Vaya a los comandos File > Create > GeoReference...en la ventana de creacion de la
georreferencia seleccione GeoRef 3-D display, asigne 600 x 800 a la grilla (Rows, Columns), y como
modelo digital de terreno (D7TM) seleccione el MED REGIONAL, click OK (Figura 18.1).

ESTOWIS 3031 Academic - [D:DELL LAPTOPAFOT. NUEVD 2]

) Fle EdE Operstiors View Window Help
o T ¢t
Ciper. .. Segment Map... r ey p——— = S
B open as Tae Raster Map... DD BR BB e
' |ﬁ Open Pxel Informetion Lﬂ::uﬂ TELEDETECCION\PRACTICASIPORTAF
Crabe Pyranid Layers Object Colection... , EHIIEI.-!-DES
Preferences Layout, . " Créale Geodeferance x|
¥ Graph...
Sm‘“t?""mr Rivse Disgram. .. GeoAsfessnce Hawe [WED FEG_ 300 ]
Import b [Repeesentation,.. I |
o Dot [ cecnsierence, | [N
5 Cocrdnate System. .. B eallisl Tiapaia
F& it Ak+F4
O TR p— 0 SEL " Geofiel Dazat Lines
) b_2004 Z Dimensicnal Table... i Gkl Otho P
:J a-7i3 FI‘!r...
-"_I B_2012 Furction, ...
] B-2013 Scnpk....
CURS0S 51G ¥ TELEDETECCIC i
_al ] PRACTICAS i LAMPE RIS
+ (2] DATOS_POBLACIONS, I CAMPO_ELIAS
+ (211 DIGITALIZACION_TRL) CAMPO_ELIAS
+ | GECRREFERENCIACI LAMPO_ELIAS
# [ HOSPITALSEGURG | CAMPO_ELIAS
# (] IMAGENES TRUJILLG « co2?
# (] TNCENDIOS ccd72 _ ] he |
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18.2.- Se despliega una ventana reo
BigDiwarce

de didlogo en la cual e [
seleccionamos I Rttel Drogs =
MED REGIONAL, como

representacion elevation24'y

Cantidad de pixeles (Pixel steps) _

1, click OK (Figura 18.2). e Bt
[ Rader Oraps
Duap= Map | EYMED_REGIONAL =]
Piegresertalion [ etevaton2e :jﬁ

[OK ] concet | Hebo |
.
Figura 18.2

18.3.- Probablemente el sistema demora un poco en la visualizacion de la informacion espacial, una vez
llegado al despliegue ilustrado en la figura 18.3, procedemos a asignar una altura de representacion
(Scale Height), de 4, y a superponer las capas poligonales: AGUA, EMBALSE DE AGUA VIVA,
CAMPO ELIAS 'y las capas de segmentos: HIDROGRAFIA,  TRUJILIMITE,
MUNICIPIO CAMPO ELIAS, VIAS CAMPO_ELIAS.

18.4.- Una vez elaborada la vista salga del editor mediante el icono correspondiente el resultado
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18.5.- La vista lograda en la figura 18.4, podria ser editada dentro de una plantilla sin embargo dado el
volumen de datos que esta posee y la proyeccidbn como se presenta, su manejo suele ser pesado para
computadores de bajo rendimiento de tal manera que en este caso haremos capturas de pantalla las
cuales luego podemos editar expeditamente a través de visores/editores de imagenes como los
senalados en esta practica: IrfanView, Impress Open Office y PowerPoint.

Las figuras 18.5a y 18.5b, ilustran el acabado final de estas, guardelas en la carpeta IMAGENES como
RELIEVE 3y RELEIVE 4 respectivamente y en formato Tiff el cual preserva mejor la resolucion.
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| PUNTOS EXTREMOS ALTITUDINALES |

19.- Los puntos extremos altitudinales sefialan donde estd ubicado el lugar de mayor altitud (msnm) y
el lugar con la altitud mas baja. Aunque el SIG puede senalarnos la ubicacion de estos puntos extremos,
en este ejercicio recomendamos que se localicen manualmente, para este proposito utilizaremos el
MED CAMPO _ELIAS, y crearemos un mapa de puntos para marcar estos lugares.

19.1.- En la pantalla maestra del ILWIS haga una vista compuesta de MED CAMPO_ ELIAS con las
capas de segementos: HIDROGRAFIA, MUNICIPIO CAMPO ELIAS, CAMPO ELIAS,
VIAS CAMPO ELIAS vy la capa poligonal CAMPO_ELIAS. Revise las areas donde se producen
estos puntos extremos y verifique con el cursor la altitud de estos pixeles (Figura 19.1).

19.2.- Haga acercamientos en las 4reas de estos puntos extremos, como se necesita aumentar el
contraste de la representacion despliegue nuevamente las opciones de despliegue del
MED CAMPO ELIAS y varie el realce (Stretch) segin los niveles ilustrados en las figuras 19.2.a y
19.2b. Escriba aparte las altitudes extremas consideradas. Vuelva a representar la totalidad del
municipio en la pantalla de despliegue, para restaurar el realce inicial escriba en el realce (Stretch) 574
y 3545 los cuales son los valores maximos y minimos que presenta el MED.

SMED_CAMPO_ECTAS: MapSubMapCoords (MED_REGIONAL.mpr, 371133.7100... l=l.. _D X
Fle EX Loyes Optons Heb

DOk &y B @ 5%z ]
1] <

& MR vias_campo_t | N
i+ B5 Properties |
=5 Legend

—¥I&_PRI
IR _SEC
=i campo_elias -
&3 |1§|' Properties
CAMPO
: MUNIC
PARR
[_Jrarra
= A hidrografia_t
+ (5 Properties
= HE Legend
- —ris 2
— TRUIILL
= MBS municipio_can
& B Properties
= Legend

175,173 [( 386580.81, 1036671.28) A
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tapSubiapCoords(MED_REGIONAL. mpr, 371133.71000000002,1032434

Damain Value valug

¥ Irfa
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19.3.- Una vez sobre el despliegue completo de la vista, genere un mapa de puntos a nombrar
PUNTOS _EXTREMOS con un dominio de clases del mismo nombre con dos categorias: MAYOR
ALTITUD 3540 msnm y MENOR ALTITUD 643 msnm (Figura 19.3), click OK y marque en la vista
los puntos extremos correspondientes, salga del editor y vuelva a la pantalla de despliegue.

Save View
Save Wiew As...
Create Layout

Properties 3
Open Pixel Information

tap Hame [PUNTDS_EXTREMOS |

Dascripﬁon:

Exit Alt+F4

Coordinate Sestem trujilla5

Mir s, [371042.821 | [1032464525 |
Max .Y 388233821 | [1054334825 |
Damain I@UniquelD j;] | l

[romain Mame - |PUNTDS_E><THEMDS

Type
1+ Class ™ Group - ==
7 Identifier ('@ Domain Class "puntns_e'xfr"e'rnus“ - IEWIS
£ Bool File Edit “iew Help
 Walue | Desciption [Domain Class "PUNTOS_EXTREMOS"
s [F@a s g s
bl
o Clazs Marme i | Code | [esn

Description: MATOR ALTITUD S540 manm

| | MENOR ALTITUD “E43 manm

(Create a new paint map 1,5 [ 371675.90, 1054292.73) OK_| Cancel | Help |
Figura 19.3
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19.4.- Edite la leyenda siguiendo las especificaciones ilustradas en la figura 19.4.

File Edit Layers Options Help

DB X Oeey B

=iEALS puntos_extremos [
o #E Properties

vias_campo_elias

Properties

¢ Legend

—W%IA_PRINCIPAL

——NIA_SECUNDARIA
iF B campo_elias - Polygania

i Properties

Legend

[ campo ELIAS

-MUNICIPIO CAMPOD

[rarrogUIA ARNOL

[ Irarrocuia campe

hidragrafia_trujilla
Properties

-4

=)

3

dit Repr. Ttem

540 msnm: MAYOR ALTITUD

Hi

resentatian Clase "BD TOS EX TREMOS = 1WA LR N T =l
View Help 5 pmbol I‘TGUDLI
J Description IHepresentation Class "PUNTOS_EXTREMOS" Size -
|> @ ® & FilCoor [ Gray ~
— il Hasta’l i) F‘olygonl Seamer|  Line \Width
g Color | white

MENOR ALTITUD
L ]

I{ 371346.60, 1049621.11)

| 9229'36,31"

Edit Repr. ltem

543 menm: MENOR ALTITUD

Symbol Type I Simple _'J
Synibcl [¥ Detts Dov ~|

Size

Fill Calar M Gray -]
Lnewidh [T |

Colar | whie

Figura 19.4
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19.5.- Guarde la vista con el nombre de PUNTOS EXTREMOS, cierre la pantalla de despliegue y
regrese a la pantalla maestra del ILWIS (Figura 19.5)

Create k
Save Yiew
Save Yisw Az,

Create Layout

Properties r
Cpen Pixel InFormation

Alt-+F4

3 Save View As

FHRAER campo_elias -
Properties
Legend tap View Name |PUNTUS_E><TF|EMUS

Title | |

oK I Eahcell Help |

hidrografia_trimms ——
Properties i
Legend

Save all layers as a map view with a new name 43,4 I 371346.60, 1050506.02) | 9°30'05.12"N, 70°10'19.46"

19.6.- En la pantalla maestra despliegue la plantilla (layout) PARROQUIAS 1, ubique en la barra de
manejo la vista MapView PARROQUIAS 1 y click boton derecho para desplegar el mend, click en
Replace MapView, y escoja PUNTOS EXTREMOS, click OK. La vista que se despliega no cubre la
mitad de la plantilla destinada para tal fin, debemos entonces ampliar la vista, para ello click en el

icono liberador de escala _|, y de esta manera podrd ampliar o reducir el tamafo de la vista.
Acomode la vista a su conveniencia y proceda a reescribir los textos (Figura 19.6).

19.7.- Obviamente esta nueva vista contara con diferente titulos, leyenda, nuevas imagenes insertadas,
marcos, etc., esta vista ofrece a la plantilla varias opciones de leyenda, las cuales deben ser escogidas a
conveniencia, por ejemplo en este ejercicio se escogerd la leyenda que represente los simbolos que
representen los puntos extremos, descartando las demas para no saturar el nuevo mapa. Para activar los
textos, click sobre ellos y proceda a editarlos. (Figura 19.7). Recuerde que esta trabajando sobre la
plantilla de PARROQUIAS 1 asi que guarde estos cambios hechos como una nueva plantilla
PUNTOS EXTREMOS 1, luego exporte este nuevo mapa a formato BMP con el mismo nombre.
Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.
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| PISOS ALTITUDINALES DEL MUNICIPIO |

20.- Para la realizacion de los mapas siguientes aprovecharemos las ventajas de tener una plantilla
elaborada a la cual solo le editaremos el titulo, leyenda, etc. Despliegue el MED CAMPO_ELIAS y
sobre el superponga la capa de poligonos PISOS ALTITUDINALES, de esta manera solo se mostrara
la porcion territorial correspondiente al municipio. Superponga también las capas de segmentos:
HIDROGRAFIA, MUNICIPIO CAMPO ELIAS, VIAS CAMPO ELIAS y la capa poligonal
CAMPO_ELIAS. Como la vialidad de la capa de vias no resalta o se distingue sobre los pisos
altitudinales, haga doble click sobre el item de la leyenda via principal en la columna de manejo de
capas y cambie color y grosor del segmento que representa via principal para hacerlo mas evidente.
Guarde esta nueva vista como PISOS ALTITUDINALES 1. Cierre las pantallas de despliegue de
mapas y regrese a la pantalla maestra del ILWIS.

20.1.- En la pantalla maestra despliegue la plantilla (layout) PUNTOS EXTREMOS 1, ubique en la
barra de manejo la vista MapView PUNTOS EXTREMOS vy click boton derecho para desplegar el
ment, click en Replace MapView, y escoja PISOS ALTITUDINALES 1, click OK. La vista que se
despliega no cubre la mitad de la plantilla destinada para tal fin, debemos entonces ampliar la vista,

: . : |Zm2 . , : <
para ello click en el icono liberador de escala , y de esta manera podrd ampliar o reducir el tamafio
de la vista. Acomode la vista a su conveniencia y proceda a reescribir los textos (Figura 20.1).
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20.2.- Obviamente esta nueva vista contara con diferente titulos, leyenda, nuevas imagenes insertadas,
marcos, etc., esta vista ofrece a la plantilla varias opciones de leyenda, las cuales deben ser escogidas a
conveniencia, por ejemplo en este caso se escogerd la leyenda que represente los colores
representativos los puntos extremos, descartando las demas para no saturar el nuevo mapa. Para activar
los textos, click sobre ellos y proceda a editarlos. Guarde estos cambios hechos como una nueva
plantilla PISOS ALTITUDINALES 1 (Figura 20.2), luego exporte este nuevo mapa a formato BMP
con el mismo nombre. Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del
ILWIS.
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[ ESTRUCTURAS Y UNIDADES LITOLOGICAS |

21.- Las estructuras y unidades litologicas se refieren a los alineamientos tectonicos y conjuntos
rocosos que subyacen en la superficie terrestre. En este ejercicio esta informacion geologica esta
representada por el mapa geologico de Venezuela elaborado por el US Geological Service y FUNVISIS
(Fundacion Venezolana para las Investigaciones Sismicas) y presentado como USGS OPEN-FILE
REPORT 2006-1109, las unidades litologicas aqui mostradas corresponden a las descripciones a
encontrar en el coédigo geoloégico de Venezuela (PDVSA, 2003 (En linea:
http://www.pdv.com/lexico/)).

Una manera de presentar este mapa en el portafolio es recortarlo segin las coordenadas dadas en el
item 6.1 sin embargo dado que este mapa presenta un formato de alta calidad se considera mantenerlo
en original y editar su presentacion bajo editores de imagenes (IrfanView, PowerPoint / Impress
OpenOftice).

21.1.- Despliegue el mapa GEOLOGIA y sobre el superponga las capas de segmentos:
HIDROGRAFIA, MUNICIPIO CAMPO ELIAS, VIAS CAMPO ELIAS y la capa poligonal
CAMPO_ELIAS. Como la vialidad de la capa de vias fue anteriormente remplazada en color y grosor,
haga doble click sobre el item de la leyenda via principal en la columna de manejo de capas y cambie a
color rojo y grosor de 1 el segmento que representa via principal para hacerlo mas evidente. Guarde
esta nueva vista como GEOLOGIA 1.

Haga una captura de pantalla de esta vista, recortela con el IrfanView y llevela al PowerPoint / Impress
OpenOffice. Una vez alli edite la diapositiva y afiddale titulo, leyenda y fuentes. Un ejemplo del mapa a
editar mediante este procedimiento se ilustra en la figura 21.1, Guéardelo con formato tiff para preservar
mayor resolucion, en la carpeta de IMAGENES como GEOLOGIA 1.

MLEBICIDD CAMPD EL|IAS
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[ =t WATEIN S

PROYECCION LT
1190 SR

EiEARTEE -

Fugies
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98



Cierre las pantallas de despliegue de mapas y regrese a la pantalla maestra del ILWIS.

| FORMAS DEL PAISAJE |

22.- La geomorfologia estudia los procesos modeladores del paisaje fisico y sus formas resultantes, en
esta parte de la practica se editard un mapa relativo a las formas del paisaje derivado de su analisis
topografico. Probablemente una mejor manera de representar las formas del paisaje del municipio es
usando un MED que acentue las geoformas del municipio.

22.1.- Despliegue la georreferencia MED CE 3D1 y superponga (Drape Map) el mapa
GEOMORFOLOGIA con una malla de cada 10 pixeles (Pixel steps) para facilitar el procesamiento.
Superponga también las capas de segmentos: HIDROGRAFIA, MUNICIPIO CAMPO ELIAS,
VIAS CAMPO _ELIAS vy la capa poligonal CAMPO_ELIAS, esta ultima solo los limites de la ciudad
(Figura 22.1).
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Figura 22.1

22.2.- En la pantalla de despliegue edite la georreferencia mediante los comandos Edit >
GeoReference...de esta manera podemos hacer cambios substanciales en cuanto a la escala vertical y
demas opciones de proyeccion de la vista 3D, siga los parametros del ejemplo ilustrado en la figura
22.2, luego click en Display options y seleccione finalmente una malla de cada 1 pixel (Pixel steps),
click OK.
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22.3.- Salga del editor y guarde la vista como GEOMORFOLOGIA 1 (Figura 22.3a). Haga una
captura de pantalla de esta vista, recortela con el IrfanView y llévela al PowerPoint / Impress
OpenOffice. Una vez alli edite la diapositiva y afiddale titulo, leyenda y fuentes.

La leyenda puede lograrla de la misma manera mediante captura de pantalla de la correspondiente en la
vista y editarla con la ayuda de IrfanView, en la carpeta IMAGENES hay dos ejemplos de leyenda
geomorfo 1y geomorfo 2.

Un ejemplo del mapa a editar mediante este procedimiento se ilustra en la (Figura 22.3b), el poligono
color negro que muestra el mapa 3D municipal hacia la derecha es consecuencia de la falta de
informacién en el mapa de geomorfologia con respecto al MED. Guardelo con formato tiff para
preservar mayor resolucién en la carpeta IMAGENES como GEOMORFOLOGIA 3.
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Cierre las pantallas de despliegue de mapas y regrese a la pantalla maestra del ILWIS.

| DISTRIBUCION DE LA TEMPERATURA SUPERFICIAL |

23.- La temperatura de la superficie terrestre estd en funcion de multiples factores tales como la
radiacion, tipo de superficie, latitud, altitud, etc. En el caso del municipio Campo Elias, el factor
moderador mas importante de la temperatura es la altitud y dado que este es un territorio montafioso
con rangos de altura entre 643 y 3540 msnm es de esperar variabilidad en temperaturas superficiales y
una distribucién orientada por la altitud. La temperatura superficial aqui presentada se refiere a la
media anual calculada a partir del gradiente altotérmico medio anual e interpolada a través de SIG.

23.1.- Haga una vista compuesta de la capa raster: TEMPERATURA, las de segmentos:
HIDROGRAFIA,  TRUJILIMITE, MUNICIPIO CAMPO ELIAS, y las capas poligonales
CAMPO_ELIAS. AGUA, EMBALSE AGUA VIVA Guarde la vista como TEMPERATURA 1.
Acerque el area correspondiente al municipio Campo Elias y haga una captura de pantalla, recortela y
guarde esta imagen como temperatura_2 en formato BMP en la carpeta IMAGENES (Figura 23.1).
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23.2.- Despliegue la plantilla (layout) UBICACION 2, ubique en la barra de manejo la vista MapView
UBICACION 2 vy click botén derecho para desplegar el menu, click en Replace MapView, y escoja
TEMPERATURA 1 (Figura 23.2), click OK. La vista que se despliega no cubre la mitad de la plantilla
destinada para tal fin, debemos entonces ampliar la vista, para ello click en el icono liberador de escala

e hl

=

D)

, y de esta manera podra ampliar o reducir el tamafo de la vista. Acomode la vista a su
conveniencia y proceda a reescribir los textos.

IE: UBICACION_Z - ILWIS
File. Edit Insert Miew Help

| FHE 4 BRX|E R 8 !I'EI|

| B e HoE oo | B D H @
* | 1tem I Left | Top | Width | Height | Scale
Abe MUNMICIPIO CAMPO EL A5 211.7 16.1 Tr2 19.2
B Map Border of Map View UBICACL ., -0.7 -15.9 244.4 250,58
Tvr Scale Bar of Map Yiew UBICACION =2 219.3 188.5 9.2 5.0 1.7663853
TN Nu:urth Arrawe af Map View UBICACT. .. 164.7 279 40,2 40,2

Replace Map Yiew, ..
Save View

Save View As..,

Entire Map  Ctrl+E
Set Scale. ..

Clear

23.3.- Obviamente esta nueva vista contard con diferentes titulos, leyenda, nuevas imagenes insertadas,
marcos, etc., la vista TEMPERATURA 1 ofrece a la plantilla la leyenda de grados centigrados en
degradacion de colores. Para activar los textos, click sobre ellos y proceda a editarlos. Inserte la
imagen BMP temperatura 2 segln lo ilustrado en la figura 23.3. Guarde estos cambios hechos como
una nueva plantilla TEMPERATURA 1, luego exporte este nuevo mapa a formato BMP con el mismo
nombre. Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.
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| DISTRIBUCION DE LA PRECIPITACION ANUAL 1998 - 2014 ‘

24.- El municipio Campo Elias se encuentra en la transicion de un valle central de la cordillera de
Mérida hacia el piedemonte andino llanero, el cual recibe las masas de aire humedas procedentes de los
llanos occidentales venezolanos. La barrera montafiosa acrecienta las precipitaciones, de esta manera
las areas situadas al pie de la vertiente de barlovento y la propia vertiente son mucho mas humedas que
las zonas situadas a sotavento, eso pudiera explicar la alta humedad de la cuenca alta de los rios
Bocono y Sagiias en contraposicion de las cuencas de los rios Burbusay y Carache situados a sotavento.

Los datos de precipitacion aqui procesados corresponden a los obtenidos a través de la plataforma
Giovanni (http://giovanni.gsfc.nasa.gov/giovanni) los cuales corresponden al sistema TRMM (Tropical
Rainfall Measuring Mission), con una resolucion horizontal estimada de 25 Km. para las latitudes bajo
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andlisis. Estos datos han sido interpolados bajo plataforma SIG sin apoyo de otras fuentes de datos de
precipitacion por lo que la espacializacion resultante se considera experimental y solo para uso de
practicas docentes.

24.1.- Haga una vista compuesta de la capa raster: pp_1998 2014, las de segmentos: HIDROGRAFIA,
TRUJILIMITE, MUNICIPIO_CAMPO_ELIAS, vy las capas poligonales CAMPO _ELIAS. AGUA,
EMBALSE AGUA_VIVA Guarde la vista como pp 1998 2014 1. Acerque el area correspondiente al
municipio Campo Elias y haga una captura de pantalla, recortela y guarde esta imagen como
pp_1998 2014 _1 en formato BMP en la carpeta IMAGENES (Figura 24.1).

i pp_1998" 2074 MaplnterpolContour{pp_1998 _2074b.mps MEDEB . grf] -
File Edt Layers Options Help

DO & ey B || ]

i PARROC
= KBS hidrografia_tr
i+ B Properties
= 3 Legend
: —is_2

x

869,152 [ 404786.35, 1045695.45) | 9°27'31.70°N, .14'w_

24.2.- Despliegue la plantilla (layout) TEMPERATURA 1, ubique en la barra de manejo la vista
MapView TEMPERATURA 1 y click boton derecho para desplegar el menu, click en Replace
MapView, y escoja pp_1998 2014 1 (Figura 24.2), click OK. La vista que se despliega no cubre la
mitad de la plantilla destinada para tal fin, debemos entonces ampliar la vista, para ello click en el
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, : [ , . : N .
icono liberador de escala | , y de esta manera podrd ampliar o reducir el tamafo de la vista.
Acomode la vista a su conveniencia y proceda a reescribir los textos.
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24.3.- Obviamente esta nueva vista contard con diferentes titulos, leyenda, nuevas imagenes insertadas,
marcos, etc., la vista pp_1998 2014 1 ofrece a la plantilla la leyenda de milimetros de precipitacion:
pp (mm) en degradacion de colores. Para activar los textos, click sobre ellos y proceda a editarlos.
Inserte la imagen BMP pp 1998 2014 1 segun lo ilustrado en la figura 24.3. Guarde estos cambios
hechos como una nueva plantilla: pp 1998 2014 1, luego exporte este nuevo mapa a formato BMP
con el mismo nombre. Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del

ILWIS.
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| CLASIFICACION DE PISOS TERMICOS |

25.- Para la edicion de un mapa representativo de los pisos térmicos del municipio Campo Elias
seguiremos la plantilla de la distribucién de temperatura y precipitacion, puesto que es importante
ilustrar el comportamiento espacial de estos factores climaticos en el municipio pero insertos en el
contexto regional.

25.1.- Haga una vista compuesta de la capa poligono PISOS TERMICOS, las de segmentos:
HIDROGRAFIA,  TRUJILIMITE, MUNICIPIO CAMPO ELIAS, y las capas poligonales
CAMPO_ELIAS. AGUA, EMBALSE AGUA VIVA Guarde la vista como PISOS TERMICOS 1.
Acerque el area correspondiente al municipio Campo Elias y haga una captura de pantalla, recortela y
guarde esta imagen como pisos_termicos_I en formato BMP en la carpeta IMAGENES (Figura 25.1).
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25.2.- Despliegue la plantilla (layout) pp 1998 2014 1, ubique en la barra de manejo la vista MapView
pp_1998 2014 1 y click botén derecho para desplegar el menu, click en Replace MapView, y escoja
PISOS TERMICOS 1 (Figura 25.2), click OK. La vista que se despliega no cubre la mitad de la
plantilla destinada para tal fin, debemos entonces ampliar la vista, para ello click en el icono liberador

de escala | * 1, y de esta manera podra ampliar o reducir el tamano de la vista. Acomode la vista a su
conveniencia y proceda a reescribir los textos.

"B pp 19982014 1 - ILWIS
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25.3.- La nueva vista contard con diferentes titulos, leyenda, nuevas imagenes insertadas, marcos, etc.,
la vista PISOS TERMICOS 1 ofrece a la plantilla la leyenda de los poligonos y colores
representativos de los pisos térmicos, sin embargo en este caso utilizaremos una imagen ilustrativa de
los pisos térmicos que esta en la carpeta IMAGENES titulada pisos termicos 2. Para activar los
textos, click sobre ellos y proceda a editarlos. Inserte la imagen BMP pisos termicos I segin lo
ilustrado en la figura 25.3.

Guarde estos cambios hechos como una nueva plantilla: PISOS TERMICOS 1, luego exporte este
nuevo mapa a formato BMP con el mismo nombre. Cierre todas las ventanas de despliegue y regrese a
la pantalla maestra del ILWIS.
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:II:: PISOS_TERMICOS 1 - ILWIS

File Edit Insert ‘Wiew Help
R e B -
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Eﬁitmap 36.9 158.1 43,7 52.4
@Bitmap 177.7 58.5 0.7 146.0
Abe PROOYECCI M UTM 190N WiE534 106.9 178.2 47.2 16.0
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Figura 25.3
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| CLASIFICACION CLIMATICA DE KOEPPEN |

26.- La clasificacion climatica mundial segiin Kdeppen es la clasificacion climatica mas conocida y de
mayor aplicacion en la geografia. Su punto de partida consiste en que la vegetacion natural constituye
un indicador del clima, y algunas de sus categorias se apoyan en los limites climaticos de ciertas formas
de vegetales.

Los climas son definidos por los valores medios anuales y mensuales de temperatura y precipitacion.

Con estos criterios los climas quedan definidos en cinco grandes grupos, reconocidos por letras
mayusculas.

La primera letra o letra principal (Grupo climatico)

W. Koéeppen distingue cinco grupos climaticos principales, definidos por umbrales térmicos y de
precipitacion, que corresponden, grosso modo, a las grandes formaciones de vegetacion. Estos climas
son designados con las primeras letras del alfabeto, escritas en mayuscula: A, B, C, D y E.

Letra Umbral Térmico Clima Unidad Vegetal
- Temperatura media - Calidos: tropical lluvioso, sabana,| - Bosque ecuatorial o selva
mensual superior a18°C. monzén. tropical, sabana
- La evaporacion supera a - e .
B p P - Secos: aridos y semiaridos - Desierto, estepa

la precipitacion.

- La temperatura media del
C mes mas frio es inferior
a 18°C y superior a -3°C.

- Templados: de lluvias

. : ~ - Bosque templado y matorral
estacionales y lluvias todo el aio. q P y

- La temperatura media del
D mes mas frio es inferior a - | - Boreales: de lluvias estacionales
3°C y la del mes mas calido| y lluvias todo el afio.

es superior a 10°C.

- Bosque de coniferas

- Cuando los umbrales térmicos de los climas Templados (C) y Frios (D) ocurren en la zona
intertropical se asigna la letra G (en sustitucion de C y D y en primera posicion), que representa el
clima templado de montafia tropical

- En ningdin mes la

temperatura media supera | - Frios: tundra y hielo. - Tundra y ausencia de vegetacion
los 10°C. por presencia de hielo.

- Cuando los umbrales térmicos de los climas polares (E) ocurren en la zona intertropical se asigna
la letra H (en sustitucion de Ey en tercera posicion), que representa el clima muy frio de montana
tropical

Fuente: http://www7.uc.cl/sw_educ/geografia/cartografiainteractiva/lnicio/Paginas/Untitled-1.htm
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Condiciones para la segunda letra mayuscula

Grupo N
o Grupo climatico I
climatico . Condicién
S secundario
principal
- Si hay lluvias en invierno, la precipitacion anual, en centimetros, debe ser
igual o inferior al doble del valor de la temperatura media anual.
BS (Steppe) - Si hay lluvias en verano, la precipitacion anual, en centimetros, debe ser
Estepa o Semiaridojigual o inferior al doble de la temperatura media anual mas 28° C.
- Si las lluvias son irregulares, la precipitacion anual, en centimetros, debe
B ser igual o inferior al doble de la temperatura media anual mas 14° C.
- Si hay lluvias en invierno, la precipitacion anual, en centimetros, debe ser
igual o inferior a la temperatura media anual.
BW (Wiiste) - Si hay lluvias en verano, la precipitacion anual, en centimetros, debe ser
Desierto o Arido |igual o inferior a la temperatura media anual mas 14° C.
- Si las lluvias son irregulares, la precipitacion anual, en centimetros, debe
ser igual o inferior a la temperatura media anual mas 7° C.
E ET (Tundre) Tundra| - La temperatura media del mes mas cdlido debe estar entre 0° C 'y 10° C.
Z AjﬁW- La temperatura media del mes mas calido debe ser menor a 0° C.

Fuente: http://www7.uc.cl/sw_educ/geografia/cartografiainteractiva/lnicio/Paginas/Untitled-1.htm

Segunda letra, en minuscula (particularidades pluviométricas)

Para caracterizar el comportamiento de las lluvias se hace uso de una letra mintiscula que sigue a las
letras mayusculas. Estas letras especificamente hacen referencia a la estacion seca: f (fehlt), ausencia de
estacion seca; w (winter), estacion seca en invierno; s (sommer), estacion seca en verano; m (monzon),
estacion seca determinada por los vientos monzonicos.

Caracteristicas pluviométricas

- La precipitacion del mes mas seco es mayor a 60 mm.

- La precipitacion del mes mas seco es menor a 60 mm e igual o superior a: 100 mm —
(Precipitacion media anual en mm/25)

- La precipitacion del mes mas seco es menor a 60 mm y también inferior a: 100 mm —
(Precipitacion media anual en mm/25)

- La precipitacion de invierno (HS: de abril a septiembre, HN: de octubre a marzo) en

s centimetros igual o menor a dos veces la temperatura media anual en grados Celsius.
- La precipitacion de verano (HS: de octubre a marzo, HN: de abril a septiembre) en
BS w centimetros es igual o menor a dos veces la temperatura media anual en grados Celsius
mas 14° C.
f - La precipitacion anual en centimetros es igual o menor a dos veces la temperatura
media anual en grados Celsius mas 7° C.
s - La precipitacion de invierno (HS: de abril a septiembre, HN: de octubre a marzo) en
centimetros es igual o menor a la temperatura media anual en grados Celsius.
- La precipitacion de verano (HS: de octubre a marzo, HN: de abril a septiembre) en
BW w centimetros es igual o menor a la temperatura media anual en grados Celsius mas 14°
C.
f - Precipitacion anual en centimetros es igual o menor a la temperatura media anual en

grados Celsius mas 7° C.
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s - La precipitacion del mes mas seco en verano es inferior a un tercio de la del mes mas
lluvioso de invierno.
c W - La prgqipitgf:i()n del mes més IIuviosQ en verano es, a lo menos, diez veces mayor que
la precipitacion del mes mas seco de invierno.
f - Carece de una estacién seca. El monto de precipitacion del mes mas lluvioso esta
comprendido entre tres y diez veces la precipitacién del mes mas seco.
s - La precipitacion del mes mas seco en verano es inferior a un tercio de la del mes mas
lluvioso de invierno.
D W - La prgqipitgf:i()n del mes més IIuviosQ en verano es, a lo menos, diez veces mayor que
la precipitacion del mes mas seco de invierno.
f - Carece de una estacién seca. El monto de precipitacion del mes mas lluvioso esta
comprendido entre tres y diez veces la precipitacién del mes mas seco.
En este grupo climético, la segunda letra no es ni minuscula ni denota una caracteristica pluviométrica,
E sino que es mayuscula y precisa un rasgo térmico.
T - El mes mas calido tiene una temperatura media entre 0° C y 10° C.
F - El mes mas calido tiene una temperatura media inferior a 0° C.

Fuente: http://www7.uc.cl/sw_educ/geografia/cartografiainteractiva/lnicio/Paginas/Untitled-1.htm

Tercera letra, en minuscula (particularidades térmicas)

Grupo I S
>rup Tercera letra Caracteristicas térmicas
climético
- Régimen térmico del Ganges, con maximo térmico mensual anterior al solsticio
9 de verano del hemisferio respectivo.
, - Régimen térmico del Sudan, con maximo térmico mensual posterior al solsticio de
9 verano del hemisferio respectivo.
h (heiss) - La temperatura media anual es superior a 18° C.
BS k (kalf) - La temperatura media anual es inferior a 18° C.
K’ - Las temperaturas media anual y media mensual del mes mas calido es inferior a
18° C.
h - La temperatura media anual es superior a 18° C.
k - La temperatura media anual es inferior a 18° C.
BW K - Las temperaturas media anual y media mensual del mes mas calido es inferior a
18° C.
n (nebel) | - Presencia frecuente de nieblas.
a - La temperatura media del mes mas calido es superior a los 22° C.
b - La temperatura media del mes mas calido es inferior a los 22° C y, al menos,
cuatro meses, con temperaturas medias que superan los 10° C.
C - La temperatura media del mes mas frio es superior a -38° C y el mes mas calido
c es inferior a 22° C, y menos de cuatro meses tienen una temperatura media que
supera los 10° C.
1 - Las temperaturas medias de todos los meses del afio se encuentran entre 10° C y
(lauwarm) 220 G
a - La temperatura media del mes mas célido es superior a los 22° C.
b - La temperatura media del mes mas calido es inferior a los 22° C y, al menos,
cuatro meses, con temperaturas medias que superan los 10° C.
- La temperatura media del mes mas frio es superior a -38° C y el mes mas calido
D c es inferior a 22° C, y menos de cuatro meses tienen una temperatura media que
supera los 10° C.
I - Las temperaturas medias de todos los meses del afio se encuentran entre 10° Cy
22° C.
d - La temperatura media mensual del mes mas frio es inferior a los -38° C.
E

Fuente: http://www7.uc.cl/sw_educ/geografia/cartografiainteractiva/lnicio/Paginas/Untitled-1.htm
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26.1.- Para la ediciéon de un mapa representativo de la clasificacion climatica segin Kdeppen del
municipio Campo Elias seguiremos la plantilla elaborada para el disefio del mapa de pisos térmicos,
puesto que es importante ilustrar la zonificacion del clima en el municipio pero insertos en el contexto
regional. Haga una vista compuesta de la capa poligono CLIMA KOPPEN, las de segmentos:
HIDROGRAFIA,  TRUJILIMITE, MUNICIPIO CAMPO ELIAS, y las capas poligonales
CAMPO _ELIAS. AGUA, EMBALSE AGUA VIVA. Guarde la vista como CLIMA KOPPEN 1.
Acerque el area correspondiente al municipio Campo Elias y haga una captura de pantalla, recortela y
guarde esta imagen como clima_koppen_1 en formato BMP en la carpeta IMAGENES (Figura 26.1).

G CLIMA_KOPPEN: PolygonMapFromsegment (CLIMAT, ™ CLIMAT. mpp) = IEWIS
| File Edit Lawers Options Help

Il =RAED embalse_agu-[:]

Properties
¢ Legend
- JleveaLst
1ifA B agua - Polyge
' Properties
¢ Legend

-bocono—l
i -masparn

|- A hidrografia_tr
i Properties
¢ Legend
f——rins_2
. ——TRUMILL
=1 A ER municipio_can
; Properties
¢ Legend
- ——LIMITE_|
L LIMITE_|
= BB trujilimite
DB - Properties I}ﬂ
T8 [2)

x

26.2.- Despliegue la plantilla (layout) PISOS TERMICOS 1, ubique en la barra de manejo la vista
MapView PISOS TERMICOS 1 y click boton derecho para desplegar el ment, click en Replace
MapView, y escoja CLIMA KOPPEN 1 (Figura 26.2), click OK. La vista que se despliega no cubre la
mitad de la plantilla destinada para tal fin, debemos entonces ampliar la vista, para ello click en el

. : |:mj . : : N :
icono liberador de escala , y de esta manera podrd ampliar o reducir el tamafo de la vista.
Acomode la vista a su conveniencia y proceda a reescribir los textos.
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Fil=  Edit

Insert  View Help

Them i Left | Top | ‘width | Height | Scale |
fAbe MIUMICIFIO CAMPO EL AS 1829 11.3 TrZ 19.2
B Map Border of Map Yiew PISOS_T... -4.3 -13.1 190.8 194.0
Twr Scale Bar of Map Yiew PISOS_TER... 110.5 162.6 56,4 8.0 11967633
Trq Marth Arraw of Map Yiew PISOS T... 121.3 21.3 316 316
ap Vi PLS — - A e

Sawve Yiew

Sawve Yiew As,..

Entire Map Ctrl+E

Sek Scale. ..

Mapisw | CLIMA_KOPPEN_T -
= MUEWD_2 [
ik CLIN A KOPPER 1
Y GEOLOGIA_1
- GEOMORFOLOGIA_1
&) LIMITES_1
B PARROGUIAS_T

Y PISOS_ALTITUDINALES,
Y PIS0S_TERMICOS_1
[ pp_1998_2014.1

Y PUMTOS_EXTREMOS 09

Y TEMPERATURA. 1 '

Clear

26.3.- La nueva vista contard con diferentes titulos, leyenda, nuevas imagenes insertadas, marcos, etc.,
la vista CLIMA KOPPEN 1 ofrece a la plantilla la leyenda de los poligonos y colores representativos
de los tipos climaticos. Para activar los textos, click sobre ellos y proceda a editarlos. Inserte la imagen
BMP clima_koppen 1 segln lo ilustrado en la figura 26.3.

Guarde estos cambios hechos como una nueva plantilla: CLIMA KOPPEN 1, luego exporte este
nuevo mapa a formato BMP con el mismo nombre. Debido a la complejidad que posee la leyenda de la
clasificacion climatica de Kdeppen, el mapa solo presentara los cddigos, queda disefiar una tabla de
apoyo al mapa que sea mas explicita en el significado de dichos cddigos. El estudiante debe entonces
interpretar los cddigos segtin los soportes dados en las tablas presentadas en el item 26.
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File Edit Insert ‘iew Help
EEEIRET AL SN =1k
ancmmﬁiﬁ_j@‘ﬁu e ng|@]@]|;ﬁ:@

Iter | Left | Top | ‘width | Height | Scale

] Bitmap 172.1 B6.5 88,7 132.4
87 | pgend of CLIMA_KOPPEN. mpa of ... 74,9 152.1 54,3 56,0
[ Box 170.5 B5.3 92,4 134.4
Abe PROYECCT M UTM 190 WiESE4 106.9 178.2 47.2 16.0
RAbe Clasificaci n clim tica seg n K eppen 158.5 43.3 115.2 14.8

262414 414186
) 1 23390 MUNICIPIO
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974034 !ﬁ ﬁll 974034

262414 414186

B am B ET

- A - ETH 0 40 km
PROYECCION LT

[ ] esn B o 18N WIGSE4

[ ek [] cwb
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Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.
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| DISTRIBUCION DE LAS CUENCAS HIDROGRAFICAS |

27.- Las cuencas hidrograficas son las unidades territoriales productoras de agua, tienen la capacidad de
concentrar en un solo drenaje la precipitacion caida en su extension territorial, las caracteristicas
geomorfométricas, relieve, conservacion y equilibrio de su cobertura vegetal, transforman a la cuenca
hidrogréfica en un administrador del recurso agua.

El municipio Campo Elias se emplaza en una de las zonas mas lluviosas del estado, y participa de dos
importantes cuencas hidrograficas como lo son las correspondientes a los rios Bocond y Sagiias-
Guanare.

Para la determinacion de las cuencas hidrograficas del municipio es necesario: 1.- Ubicar los rios
principales asociados al municipio Campo Elias y la extensiéon de la cuenca drenada sobre un el
MED REGIONAL, 2.- Digitalizar los limites de estas cuencas o secciones de cuenca, 3.- Crear
poligonos de estas areas para su posterior edicion en el mapa correspondiente, 4.- Representar estas
cuencas.

27.1.- Como ya se sefialo arriba, los principales rios cuyas cuencas participan del territorio del
municipio Campo Elias son los rios Bocond y Sagiias. Para la revision de los limites de estas cuencas
utilizaremos tres despliegues: MED REGIONAL con representacion de elevation 24,
MED_REGIONAL con representacion Grey y un mapa de relieve sombreado el cual lo realizaremos
mediante los comandos: DEM Visualization....., en la pantalla de didlogo escogemos
MED_REGIONAL y llamamos al producto RELIEVE_ SOMBRAS 1.

A los tres despliegues les superponemos las capas de segmentos: HIDROGRAFIA, vy
MUNICIPIO_CAMPO _ELIAS, y las capas poligonales AGUA y EMBALSE AGUA VIVA (Figura
27.1a).

A grandes rasgos y basandonos en el MED REGIONAL elevation 24, las cuencas de los rios Bocond
y Sagiias se ilustrarian como en la figura 27.1b.
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27.2.- Amplie la ventana donde esta desplegada la vista del MED REGIONAL con elevation 24,
genere un mapa de segmentos (segment map), a llamar CUENCAS, con dominio de clases también
CUENCAS, a través de los comandos ilustrados en la Figura 27.2.

Som Ll PN S LR [ [Te2E eeae 1.1 4630 16707 - ILWIE
W rie B Lowess Cpfions el

~IEAE agua - Pakigaris
“ Fiopariss I
E Lagared

prohn ! SLE [

= . » 5 [=IREEH]
LR o 18

3 ST
=1 Crnata (lremain

= BN hidragrafia - = Lhu:.;-[l
a Fropatims _.'_...l_ S e i I ..
Dwrusn Here [TUENCAS
Ceauption Ciarmen Dz SCUERCES" i
FE= Al b s L R
Tiats Howes Tinds Desaipam :
Hoal
T
747
a2 Wik ]
B P
= - (5] e
27.3.- Cierre las ventanas

correspondientes a Representacion 'y
Dominio y finalmente haga clic en OK

en la ventana de creacion del mapa de Mo B i M
Edit Layer 1 map MED_REGICMAL

Segmentos' De estg mancra uSted ha : 1 Edit Other Map 2 seq hidrografia_trujilla
entrado en el editor del mapa de ||| representaton > 2P0lo0
segmentos y se dispone a trazar 10s || poman feclefizebproaumite,

limites de las cuencas hidrograficas de i b GeoRefersnce
¢ Coordinate System

los rios Bocon6 y Sagiias-Guanare. En | i}  —==pmmrre~
los dos despliegues restantes I_@m;;l;:”;s;'
superponga la capa de segmentos ||| - Properties
CUENCAS vy edite esta capa segun lo _LE-QEQSBALSE
que muestra la figura 27.3, de esta | (| SifAED aqua-Poivacy |
manera cuando no este seguro del ] )
trazado del limite puede apoyarse en los | |

otros despliegues.




=

una vez terminado revise la consistencia de

. , ¥ £ -
los segmentos mediante el modulo de chequeo con los iconos y los cuales son utiles para la

correccion de los problemas de solapamiento, interseccion y terminaciones que puedan presentar los

segmentos, asegurese que los segmentos sean consistentes en cuanto a su definicion (CUENCAS). Los
Segmentos que definen la cuenca del rio Bocon6 deben conformar un poligono cerrado, igualmente los
que definen la cuenca del Saglias-Guanare (Figura 27.4). Una vez terminada la digitalizacion salga del
=+

27.4.- Trace el la divisoria de aguas del rio Bocon6

editor de mapas de segmentos
automaticamente.

de esta manera todo el trazado elaborado se guarda

Figura 27.4

Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.

28.- Los mapas de segmentos BN y mapas de poligonos@[ son mapas vectoriales, mientras los
segmentos dan cuenta de la conectividad de los vectores, los poligonos representan el area contenida
por un conjunto de vectores. Para operaciones espaciales y algebra de mapas, en la mayoria de los SIG,

los mapas de poligonos deben ser rasterizados a una georreferencia = que defina el tamafo de celda.
En esta parte del ejercicio, se crearan los poligonos que representen la cuenca del Rio Bocond y la
cuenca del Rio Sagiias-Guanare.
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28.1.- Para generar estas capas de poligonos a partir del mapa de segmentos CUENCAS, se requiere
crear una etiqueta que asigne una categoria al area contenida en los vectores. Esta etiqueta se genera

mediante un mapa de puntos

B CLITHERS - LWIS

. | Crewe ] Ponihw. [y
28.2.- Despliegue la capa de L

A Vil Saginenh Maf,.
Save Ve BN, Faser Map. ..
segn’lentos CUENCAS, y a Comabe Laymut Sarscle Sot.
través de los comandos File P ———
. T 3 Coordinats Syshem.
> Create > Point Map, CpenPuel Infaimakion
genere un mapa de puntos £k ih+Fs  Subman.

llamado igualmente
CUENCAS, asigne el

P Creale Painf M

dominio ya creado Wohes  [CERCE |

CUENCAS (Figura 28.2). e | r—

Click OK. Cosrae yter: - o >
MY | EE N B Cra b T | o T 4
Mty [z s | [ilEeas | pou
Do [T =] ]

DO & 88 4y B [ ]
L

B Ty

28.3.- En el editor del mapa
de segmentos, click en el
poligono correspondiente a la
cuenca del rio Bocono y
asigne una nueva (new)
categoria, esto es necesario
pues el dominio CUENCAS
solo posee una. Las categorias
a afiadir son: CUENCA DEL
RIO BOCONO y CUENCA
DEL RiO SAGUAS-
GUANARE, asignele algun
color el cual luego podra ser
editado (Figura 28.3).
Termine las etiquetas o puntos
y salga del editor. Cierre el
mapa de puntos CUENCAS.
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29.- Proceda a poligonizar, ubiquese en la pantalla maestra del ILWIS y haga click con el botén
derecho del raton sobre el mapa de segmentos CUENCAS. Seleccione el comando Vectorice >
Segment to Polygon... La ventana de dialogo (Figura 29a), le pedird la etiqueta a utilizar en la
poligonizacion, escoja el mapa de puntos CUENCAS elaborado para tal fin, llame al nuevo mapa de
poligonos CUENCAS, clickc en Show y despliegue el mapa de poligonos. Cierre el mapa (Figura 29b)
y regrese a la pantalla maestra del ILWIS.

 CAMPD £ (4 (& LIMITE | Polygonize Segment Map

Open %) limnite_filas

Statistics Y R limite_filas

Contour Interpolation, .. g lrvite,_filas Seqrment Map ] R CUEMCAS ﬂ
Vector Operations 4 LIMITES_1 4

Rasterize P IEh it 4 A

Segment taPalygon. .. i Topology

I Segment ta Pointk, .. e E e 1 CUENCAS _:i
:L?tperties mEB?SDm 7 Unigue Identifiers
Copy Chrl+C EAMED_CAMPO_ELIAS [ Auto Conection
Delete Dl ERIMED_CamMPO_ELIAS

Output Polygon M CUENCAS
Help EAMED_CE_301 siput Foloemtizn: | |

ERMED_ESTADD Description:

EAMED_REG_2D1 | |
128 elevationz4 EEMED_REGIOMAL
&%) EMBALSE E3MUN_CAMPD_ELIAS Shawm ] Dehne ] Cancel 1 Help 1
% EMBALSE R MUMN_CAMPO_ELIAS

HAGA UNA CAPTURA
DE PANTALLA DE
ESTE MAPA DE
POLIGONOS Y
PONGALO EN LA
PLANTILLA DE
EVALUACION

I

Figura 29b

Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.

30.- En la pantalla maestra del ILWIS, ubique y despliegue la capa RELIEVE SOMBRAS 1,
superponga la capa poligonal CUENCAS vy en la pantalla de didlogo antes del despliegue asignele una
transparencia del 60% (Figura 30a).
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30.1.- Adiciénele las capas de segmentos: HIDROGRAFIA, TRUJILIMITE,
MUNICIPIO CAMPO _ELIAS, y las capas poligonales CAMPO _ELIAS. AGUA,
EMBALSE AGUA_VIVA. Guarde la vista como CUENCAS 1.

30.2.- Para la edicion de un mapa representativo de las cuencas del municipio Campo Elias seguiremos
la plantilla elaborada para el disefio del mapa de clima Koeppen puesto que es importante ilustrar las
cuencas en el municipio pero insertos en el contexto regional. Despliegue la vista CUENCAS 1 y haga
un acercamiento al area correspondiente al municipio Campo Elias, haga una captura de pantalla,
recortela y guarde esta imagen como cuencas I en formato BMP en la carpeta IMAGENES (Figura
30.2).
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30.3.- Despliegue la plantilla (layout) CLIMA KOPPEN 1, ubique en la barra de manejo la vista
MapView CLIMA KOPPEN ly click botén derecho para desplegar el menu, click en Replace
MapView, y escoja CUENCAS 1 (Figura 30.3), click OK.

Esta vista es muy pesada para computadores de bajo rendimiento por lo que en algunos casos se
recomienda hacer la plantilla (Layout) desde el principio. Igualmente es de notar que cuando se hace la
plantilla la transparencia de los poligonos de las cuencas se pierde, por lo que se puede sugerir editar la
vista en IrfanView y llévarla al PowerPoint / Impress OpenOffice. Acomode la vista a su conveniencia
y proceda a reescribir los textos e ingresar la leyenda.
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30.4.- La nueva vista contard con diferentes titulos, leyenda, nuevas imagenes insertadas, marcos, etc.,
la vista CUENCAS 1 ofrece a la plantilla la leyenda de los poligonos y colores representativos de los
tipos climaticos (Figura 30.4a).
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Para activar los textos, click sobre ellos y proceda a editarlos. Inserte la imagen BMP cuencas 1 segin
lo ilustrado en la figura 30.4b. Guarde estos cambios hechos como una nueva plantilla: CUENCAS 1,
luego exporte este nuevo mapa a formato BMP con el mismo nombre.

File Edit Insert Wiew Help
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Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.
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| PRINCIPALES DRENAJES |

31.- Para editar y presentar los drenajes del municipio se utilizara la capa de hidrografia, la informacion
esencial a comunicar son los nombres de los rios y quebradas, el SIG ILWIS posee formas que
permiten la edicion de textos sin embargo en aras de una elaboracion mas rapida y practica, se sugiere
editar la vista en IrfanView y llévarla al PowerPoint / Impress OpenOffice. La informaciéon sobre
nombres de los drenajes se puede consultar en el mapa TRUJILLO MUNICIPIOS.

31.1.- Elabore una vista con las capas de poligonos: MUNICIPIO_CAMPO_ELIAS, CAMPO_ELIAS
y las capas de segmentos: HIDROGRAFIA, CUENCAS, TRUJILIMITE. Guarde la vista como
DRENAIJES 1. Cierre las ventanas y regrese a la pantalla maestra.

31.2.- Despliegue la plantilla (Layout) GEOLOGIA 1, ubique en la barra de manejo la vista MapView
GEOLOGIA 1y click boton derecho para desplegar el ment, click en Replace MapView, y escoja
DRENAIJES 1 (Figura 31.2), click OK.
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“Figura 31.2

31.3.- La nueva vista contard con diferentes titulos, leyenda, nuevas imagenes insertadas, marcos, etc.,
la vista DRENAJES 1 ofrece a la plantilla la leyenda de los poligonos y colores representativos de
municipio y ciudad de Campo Elias. Para activar los textos, click sobre ellos y proceda a editarlos.
Guarde estos cambios hechos como una nueva plantilla: DRENAJES 1 (Figura 31.3), luego exporte
este nuevo mapa a formato BMP con el mismo nombre. Cierre todas las ventanas de despliegue y
regrese a la pantalla maestra del ILWIS.
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[ DISTRIBUCION DE LAS COBERTURAS Y USOS DE LA TIERRA |

32.- La cobertura de la tierra es la cubierta revestimiento bio-fisica que se observa sobre la superficie
terrestre. La cobertura puede ser natural o artificial, pudiendo clasificarse en distintos tipos de
vegetacion, cuerpos de agua, afloramientos rocosos, suelos desnudos, glaciares o areas urbanas y zonas
relacionadas como aeropuertos, puertos, zonas industriales y carreteras.

Los mapas de la Cobertura de la tierra pueden contribuir a la elaboracion de planes de ordenamiento
territorial, zonificaciones ambientales, a la gestion de los recursos naturales y para identificar conflictos
de usos del territorio, es un indicador de la capacidad del territorio para sostener las actividades
humanas y de la susceptibilidad a la degradacion del ambiente.

Los cambios en la cobertura terrestre pueden ser indicadores directos de procesos de degradacion como
la deforestacion, deslizamientos, incendios o indirectos, a través de la deteccion de cambios de uso de
las tierras tales como la extension de la frontera agricola, la urbanizacion, la desertificacion que
impliquen mayores riesgos de degradacion.

El uso de imagenes satelitales bajo SIG permiten una elaboracion rapida de la coberturas y usos de la
tierra, un preciso monitoreo temporal y posibilidades de modelizacion. Las técnicas y métodos para
procesar informacion de cobertura de la tierra a través de teledeteccidn son numerosas, basandose la
mayoria en indices de vegetacion.

La imagen COBERTURAS 1996 con la cual se trabajard en este ejercicio, se basa en la clasificacion
supervisada del indice diferencial normalizado de vegetacion (NDVI, Normalized Differential
Vegetation Index) calculado a partir de imagenes LANDSAT 5 TM (USGS Landsat Program, 2015,
Landsat ™ scene WRS2/p006/r053/006053081396, 1996-08-13 (En linea:
http://glcfapp.glcf.umd.edu:8080/esdi/ftp?id=15969).

32.1.- Haga una vista compuesta de la capa raster: COBERTURAS 1996, las de segmentos:
HIDROGRAFIA, TRUJILIMITE, MUNICIPIO CAMPO ELIAS, CAMPO ELIAS y las capas
poligonales. AGUA, EMBALSE AGUA VIVA Guarde la vista como COBERTURAS 1996 1.
Acerque el area correspondiente al municipio Campo Elias y haga una captura de pantalla, recortela y
guarde esta imagen como coberturas 1996 I en formato BMP en la carpeta IMAGENES (Figura
32.1).
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32.2.- Para la edicion de un mapa representativo de las coberturas del municipio y del estado
seguiremos la plantilla elaborada para el disefio del mapa de cuencas hidrograficas puesto que es
importante ilustrar la cobertura superficial del municipio pero insertos en el contexto regional.
Despliegue la plantilla (layout) CUENCAS 1, ubique en la barra de manejo la vista MapView
CUENCAS 1 y click botén derecho para desplegar el menu, click en Replace MapView, y escoja
COBERTURAS 1996 1 (Figura 32.2), click OK.
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32.3.- La nueva vista contard con diferentes titulos, leyenda, nuevas imagenes insertadas, marcos, etc.,
la vista COBERTURAS 1996 1 ofrece a la plantilla la leyenda de los poligonos y colores
representativos de los tipos de cobertura de la tierra (Figura 32.3a). Para activar los textos, click sobre
ellos y proceda a editarlos. Inserte la imagen BMP cuencas I seglin lo ilustrado en la figura 32.3b.
Guarde estos cambios hechos como una nueva plantilla: COBERTURAS 1996 1, luego exporte este
nuevo mapa a formato BMP con el mismo nombre.
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File Edit Insert “iew Help
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Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.
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| PARQUES NACIONALES Y AREAS DE CONSERVACION |

33.- Se denomina como area protegida a aquel espacio que como consecuencia de las diversas
condiciones que presenta: la singularidad de sus especies, muchas generalmente en peligro de
extincion, las riquezas materiales o el patrimonio cultural, entre otras, es resguardado legalmente por el
estado para que no se lo intervenga de ninguna manera que atente directamente contra su estado y
conservacion. Cabe destacarse que segin la naturaleza de aquello que se conserva nos podremos
encontrar con diversos tipos de areas que han sido clasificadas de la siguiente manera: area protectora
de flora y fauna, 4rea protectora de recursos naturales, parques nacionales, reserva de biosfera y area
recreativa urbana (http://www.definicionabc.com/medio-ambiente/area-protegida.php).

33.1.- Haga una vista compuesta de la capa raster: MED REGIONAL con representacion de
elevation_24, las capas poligonales: AGUA, EMBALSE AGUA VIVA, ABRAE TRUIJILLO 2, las
de segmentos: HIDROGRAFIA, TRUJILIMITE, MUNICIPIO CAMPO_ELIAS, CAMPO_ELIAS.
Guarde la vista como ABRAE TRUJILLO 3. Acerque el area correspondiente al municipio Campo
Elias y haga una captura de pantalla, recortela y guarde esta imagen como abrae_trujillo 3 en formato
BMP en la carpeta IMAGENES (Figura 33.1).
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Figura 33.1

33.2.- Para la edicion de un mapa representativo de las coberturas del municipio y del estado
seguiremos la plantilla elaborada para el disefio del mapa de coberturas de la tierra puesto que es
importante ilustrar la distribucion espacial de las ABRAE tanto a nivel municipal como regional.
Despliegue la plantilla (layout) COBERTURAS 1996 1, ubique en la barra de manejo la vista
MapView COBERTURAS 1996 1 y click botdén derecho para desplegar el menu, click en Replace
MapView, y escoja ABRAE TRUJILLO 3 (Figura 33.2), click OK.
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33.3.- La nueva vista contard con diferentes titulos, leyenda, nuevas imagenes insertadas, marcos, etc.,
la vista ABRAE TRUJILLO 3 ofrece a la plantilla la leyenda de los poligonos y colores
representativos de los parques nacionales, monumentos y demas areas de conservacion (Figura 33.3a).
Para activar los textos, click sobre ellos y proceda a editarlos. Inserte la imagen BMP abrae_trujillo 3
segin lo ilustrado en la figura 33.3b. Guarde estos cambios hechos como una nueva plantilla:
ABRAE TRUIJILLO_ 3, luego exporte este nuevo mapa a formato BMP con el mismo nombre.
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Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.
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[ COMPOSICIONES A COLOR DE ESCENAS LANDSAT 5 TM 1996 |

34.- Las imagenes satelitales son un instrumento primordial en el andlisis de las caracteristicas y
evolucion de las distintas coberturas espaciales a encontrar en determinado territorio. Los sistemas
satelitales que proveen estas imagenes son variados, en este ejercicio utilizaremos una escena
proveniente del sistema LANDSAT particularmente el LANDSAT 5 TM (Thematic Mapper o

mapeador tematico).

El andlisis de un territorio a través de imagenes
satelitales puede realizarse visualmente o
mediante procesamiento digital en un SIG.

El andlisis visual de imdagenes se realiza
empleando tres bandas de la imagen o escena
satelital, coincidiendo con la capacidad de los
monitores empleados en computacion, los cuales
se basan en RGB (Red, o rojo, Green o verde y
Blue o azul), el cual es un modelo basado en la
sintesis aditiva (Figura 34a).

Figura 34a

Banda 2 Banda 3 Banda 4
Determinar kos
canales para
cada banda

Rojo Verde Azl

N

Combinacién
de canzles

Los monitores RGB poseen un total de tres
cafiones: Rojo, Verde y Azul, los cuales al
combinarse por adicion generan el resto de los
colores (Figura 34b y 34c).

Las bandas a combinar son las multiespectrales las cuales poseen una resolucion de 30 m y estan

constituidas por las bandas visibles o las que el ojo humano es capaz de reconocer

(1, 2, 3), y los

infrarrojos cercanos o las que el ojo humano no es sensible (4, 5) y medios (7), (Figura 34d).
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http://www.inegi.org.mx/geo/contenidos/imgpercepcion/imgsatelite/doc/aspectos_tecnicos_de imagenes landsat.pdf

34.1.- Despliegue las imagenes Landsat que estan en el archivo (Bl _LANDSAT19960813,....
B7 LANDSAT19960813), y de esta manera compruebe que todas poseen georreferencia, en caso que
no la tengan revise con el boton derecho del cursor las propiedades de cada imagen y asignele la

georreferencia

proceder a las combinaciones a reahzar

(Figura 34.1), todas las imagenes deben tener la misma georreferencia para
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34.2.- En las composiciones a color (cc) se asigna una banda de la imagen a algin color del sistema
RGB, el resultado es una imagen a color la cual no necesariamente corresponde a la realidad pero que
son creadas con fines de destacar ciertas caracteristicas ambientales. El cuadro 4 describe tres
composiciones a color (cc) clasicas.

Cuadro 4. Algunas composiciones a color (cc) realizadas con bandas de LANDSAT 5 TM.

Composicion a color (cc) Bandas RGB Descripcion
» La vegetacion luce roja pues la banda infrarrojo cercano
(banda 4), donde la vegetacion emite su mayor

reflectividad esta en el canal rojo.
cc432 Es la composicion satelital clasica, muestra poca

Falso Color

(Figura 34.2a)

interferencia atmosférica.

El agua tiene muy poca reflectividad.

Falso color natural

ccr742
(Figura 34.2b)

La vegetacion luce verde pues la banda infrarrojo cercano
(banda 4),donde la vegetacion emite su mayor
reflectividad esta en el canal verde.

Esta composicion asemeja caracteristicas naturales al ojo
humano, muestra poca interferencia atmosférica.

El agua tiene muy poca reflectividad.

Color natural

cc321
(Figura 34.2b)

Es una vista tal como la veria el ojo humano si estuviese
en la plataforma satelital.

No tiene la banda infrarroja pues el ojo humano no es
sensible a esta.

El agua aparece azulada gracias a la informacion
aportada por la banda 1.

La banda 1 registra los aerosoles atmosféricos y por ello
la imagen muestra menos contraste en las areas de
menor altitud.
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Figura 34.2a. cc432 LANDSAT 5 TM , 13 — 08 — 1996, correspondiente al estado Trujillo — Venezuela.
(Fuente: USGS Landsat Program, 2015, Landsat TM scene WRS2/p006/r053/006053081396, 1996-08-13. En
linea: http://glcfapp.glcf.umd.edu:8080/esdi/ftp?id=15969)




Figura 34.2b. cc742 LANDSAT 5 TM , 13 — 08 — 1996, correspondiente al estado Trujillo — Venezuela.
(Fuente: USGS Landsat Program, 2015, Landsat TM scene WRS2/p006/r053/006053081396, 1996-08-13.
linea: http://glcfapp.glcf.umd.edu:8080/esdi/ftp?id=15969)




---‘ 4.2C. ANDSA vIT, =U0 = 1990, CO
(Fuente: USGS Landsat Program, 2015, Landsat TM sce
linea: http://glcfapp.glcf.umd.edu:8080/esdi/ftp?id=15969)
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34.3.- El SIG ILWIS posee dos maneras de realizar las composiciones a color, en ambas se asigna una
banda de la imagen a algun color del sistema RGB. El ILWIS puede a través de una lista de mapas

realizar composiciones a color de manera interactiva 2 Color Composite Interactive o5 decir, el
practicante puede cambiar a discrecion las bandas y combinaciones asignadas. Otra manera es realizar

una composicion final R Calor omposite Ja puede guardarse y generar un nuevo producto raster
con dominio de color, esta forma no es interactiva pero tiene la ventaja que se puede mejorar su
contraste y saturacion a través de la aplicacion inmediata de realce (stretching).
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En la pantalla maestra del ILWIS, vaya a Operation- List, y cree una lista de mapas a llamar cc123457,
mediante la forma ilustrada en la figura 34.3.

Maplist  [ccl2B457

|=-| I_ .=||j_.;' SR |

34.4.- Despliegue la nueva lista de mapas cc123457, y haga la cc432, click OK y examine el resultado,
FEA gD cc123457

cambie la composicion mediante doble click cc/123457 en la columna de manejo + B! Properties Fp
el cuadro 5 se presentan algunas cc de bandas Landsat y caracteristicas geograficas a destacar, escriba
aparte cual de estas cc tiene para usted mayor valor.

@ D:\DELL_LAPTOP\FOT...\NUEVO_2

Display '0'plinns -.Map List as CulurComp

Map List "cc123457"
v Info
I Scale Limits
[ Transpatent
@ RGB Red Band [EDb4_lendsat1 3960813 ~| [3 | [14 |
' YME GreenBand  [ERb3 landsal1 3960813 ~| [2 | [133 |
€ Hsl Blus Band [i& | [z |
" Light  Momal ( Dak (" Gray
I Create Pyramid Layers

[ ok | Cancel | Heb |

Figura 34.4
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Cuadro 5. CC de bandas sugeridas con datos
LANDSAT 4 — 7, y coberturas a destacar.

COMPOSICIONES DE
BANDAS (Landsat 4 — 7) COBERTURA
=TS A DESTACAR
(Verde) U.¥O1))
7 4 3
7 5 3 .
VEGETACION
4 3 5 GETACIO
5 4 3
7 2 1 ROCAS
7 5 3
B E
4 3 5 OSQUES
3 2 1 ZONAS
5 4 3 URBANAS
7 4 3 AGUA
3 2 1 SEDIMENTOS

Una vez realizado y examinado diferentes cc, cierre la ventana de MapList y regrese a la pantalla
maestra del ILWIS.

34.5.- La cc321 o color natural mostrada en la composicion interactiva no es visible totalmente esto se
debe a la presencia de la banda 1 la cual incorpora a la composicion los aerosoles atmosféricos que en
este caso atenlan el contraste y la luminosidad, es necesario aplicar un realce (stretching) a la

composicion y para eso doble click en el comando R Color Composite de la Operation-List, realice la
cc321, seleccione un realce mediante el Histogram Equalization y asigne como mapa de salida
cc321_HE, click en Show (Figura 34.5).

Luego de examinar el resultado cierre la ventana y regrese a la pantalla maestra del ILWIS.
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34.6.- En este ejercicio se seleccionaran las cc321 y cc742 para incorporarlas al portafolio geografico
del Municipio Campo Elias.

Despliegue la cc321 HE, superpongale las capas de segmentos: HIDROGRAFIA, TRUJILIMITE,
MUNICIPIO CAMPO_ELIAS, CAMPO_ELIAS, cambie el color de los segmentos de limites para
que sean mas visibles en la vista. Guarde la vista como cc321 HE. Acerque el area correspondiente al
municipio Campo Elias y haga una captura de pantalla, recortela y guarde esta imagen como
cc321 HEa en formato BMP en la carpeta IMAGENES (Figura 34.6a).

Tip: Si el acercamiento al municipio le resulta muy oscuro, doble click en cc321 HE en la columna de
manejo y seleccione una transparencia de 25 (Figura 34.6b).
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34.7.- Para la edicion de un mapa representativo de las cc Landsat del municipio y del estado
seguiremos la plantilla elaborada para el disefio del mapa de ABRAE TRUJILLO 3, puesto que es
importante ilustrar la composicion satelital a nivel municipal como regional. Despliegue la plantilla
(layout) ABRAE TRUJILLO 3, wubique en la barra de manejo la vista MapView
ABRAE TRUJILLO 3 y click boton derecho para desplegar el menu, click en Replace MapView, y
escoja cc321 HE (Figura 34.7), click OK.

" ABRAE TRUJILLO 3 - ILWIS
| File Edit Insert WView Melp

|FHS s 2BX DRNQAOD |

B O ZE@8 W G H&
Icem Left | Top ‘Width | Height | Scale
Ab< MUNICIPIC CAMPO EL A5 175.3 12.1 5.4 B | Replace Map View -g';"
B3 Map Border of Map View ABRAE_T.., -12.3 -18.7 205.2 Z115. A oo S Rk g £,
Tne Scale Bar of Map View ABRAE_TR... 23.7 147.3 56,4 8.0
North Arrow of Map View ABRAE_,.. 121.3
I :. Map Yie i — 17.7 YoE  Map View I li
SIS -
e B ABRAE_TRUJILLO_3
Save View =2 HE
Save Yiew Bs... i
° v A MUI CLIME_KOPPEN_1
Ertire Map  Ctrl+E EoTA COBERTURAS_1996_1
Set Scale... 3 CUENCAS 1
i % 3 ey = ABR DRENAJES 1
. { = GEOLOGIA_T
GEOMORFOLOGIA_1
LIMITES 1
PARROQUIAS_1
PISOS_ALTITUDIMALES.
PISOS_TERMICOS 1
pp 1993 2014 1 r
~\l\r < | il ] >|

Figura 34.7

34.8.- La nueva vista contard con diferentes titulos, y nuevas imagenes insertadas, marcos, etc. Para
activar los textos, click sobre ellos y proceda a editarlos. Inserte la imagen BMP cc321 HEa segln lo
ilustrado en la figura 34.8. Guarde estos cambios hechos como una nueva plantilla: cc321 HE, luego
exporte este nuevo mapa a formato BMP con el mismo nombre.
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"B cc321 HE - ILWIS ="
File Edit Insert ‘Wiew Help

sE& sl X Dk Q| =|
(@ O\ |5 & e | B S E |
™ | Item | Top | Width|  Height | Scale
E Eitrnap 203.7 Frnct 66,3 93.0
Abc PROYECCI M UTM 19N WiESa4 212.5 187.7 47.2 16.0
Abe LAMDSAT 5 TM cc321 13 de agost... 201.3 5.9 70.0 14.4
Ak ESTADO TRUJILLD YEMEZUELA, 194.1 42,5 g84.0 16.8
Ak MUMNICIPIO CAMPO EL AS 202.9 23.7 a7.2 19.2 {
262395 G2 3455
1123905 H——

1]
= 1123805

MUNICIFIO
CAMPO ELIAS

ESTADD TRLMILLO
VEMEZLIELA,

LANDSAT &5 TM co327
13 de agosto de 1998

S54345 0

262395 423465 :
(= = — ] PROVECCION UTh

0 40 km 190 WEETE

Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.

34.9.- Haga la cc742 mediante la I3 Color Composite Interactive superpongale las capas de segmentos:
HIDROGRAFIA, TRUIJILIMITE, MUNICIPIO CAMPO ELIAS, CAMPO_ELIAS, mantenga el
color original de la representacion. Guarde la vista como cc742. Acerque el area correspondiente al
municipio Campo Elias y haga una captura de pantalla, recortela y guarde esta imagen como cc742a en
formato BMP en la carpeta IMAGENES (Figura 34.9).
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34.10.- Para la edicién de un mapa representativo de las cc Landsat del municipio y del estado
seguiremos la plantilla elaborada para el disefio del mapa de cc321 HE, puesto que es importante
ilustrar la composicion satelital a nivel municipal como regional. Despliegue la plantilla (layout)
cc321 _HE, ubique en la barra de manejo la vista MapView cc321 HE Yy click botoén derecho para
desplegar el ment, click en Replace MapView, y escoja cc742 (Figura 34.10), click OK.
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34.11.- La nueva vista contara con diferentes titulos, y nuevas imagenes insertadas, marcos, etc. Para
activar los textos, click sobre ellos y proceda a editarlos. Inserte la imagen BMP cc742 segun lo
ilustrado en la figura 34.11. Guarde estos cambios hechos como una nueva plantilla: cc742, luego
exporte este nuevo mapa a formato BMP con el mismo nombre.

=
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Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.
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